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Windows 10 may be the easiest 
version of Windows to use so far, 
but that doesn’t mean it lacks 
power. Underneath its simple  
surface, it’s teaming with hidden 
settings that are waiting to be 
discovered in all sorts of places  
– on the task bar, in the Start 
menu, or in the Control Panel, 
(which is still there, hidden under 
the surface, even though 
Microsoft has created a new 
Settings app).

This issue we’re aiming to show 
you where all these hidden 

settings are lurking, so you  
can improve the way you use 
Windows 10. You’ll find lots of 
valuable tips in our big feature, 
starting on page 12. 

Of course, using a PC shouldn’t 
always be just about getting stuff 
done. It’s also about having fun, 
and to that end we’ve tracked 
down 20 of the best free games 
you can play right now on 
your PC, on page 68. Just 
use the download link we 
give for each one to 
start playing today!

Welcome

SUBSCRIBE TO THE MAG TODAY  
AND SAVE – JUST TURN TO PAGE 32!

We pride ourselves in being the only 
magazine on the shelves to show you  
exactly how to get the very best from
the Windows operating system, whether 
you’re using Windows 10 or Windows 8.1. 
Also, don’t forget to take a look at how  
you can read the magazine on your laptop, 
phone or tablet.

page://32
page://98


6 Discover Watch free films online, 
make the most of Windows’ libraries,  
plus Microsoft’s new laptop

37 Back issues Don’t miss out!  
Order past issues while stocks last
 
32 Subscriptions Save up to 55%  
on print and digital issues

49 Digital issues Get your favourite 
Windows mag on your digital device

98 Next month Discover what’s 
coming up in the next issue

74 Four pages of essential 
expert help for all your 
tricky technical queries
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12 100 ways to refine Windows 10 
even smarter and faster ways to get 
everything done on your pC

60 Clean up your PC
the complete guide to reinstalling 
Windows to its very best

68 Free to play
the 20 best free-of-charge Windows 
games you should try today
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26 use Microsoft’s OneDrive to 
store all your photos and files 

30 Improvements mean it’s time 
to get gaming on Windows 10

34 tame Windows update  
and regain control of your pC

38 Set up and get the most  
from voice assistant Cortana

40 How to clean up your pC  
the safe and easy way

42 learn to bypass Settings and 
access Control panel applets

46 use paint.Net to fix problems 
with your imperfect photos

50 easily set up Microsoft’s slick 
new web browser edge

52 learn to unlock Windows 
10’s tricks and secret features

56 Write your first novel, with 
free word processor yWriter

Your guide Graham Barlow says…

“If you’re looking for better ways to use your home 
computer, then this is the place to start. We’ll show 
you all the tips and tricks the experts use and more!”

explORe  
The best PC tutorials
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www.facebook.com/windowsmag
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No ticket Look in the right 
places and you can have a free 
movie night every night
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The Knowledge…

BBC’s iPlayer is a fantastic way to catch  
up on films which have been shown on the 
channel. But there’s a hidden feature on 
the service – the ability to download 
videos and TV programs to your computer 
to watch offline. This means you can 
potentially take your laptop just about 
anywhere and watch anything – provided 
it’s within 30 days of first broadcast. To 
get started visit www.bbc.co.uk/iplayer/
install on your Windows computer.

How to watch free films 
online via your PC

The little screen

P
aramount Pictures – the studio 
behind blockbusters such as 
Mission Impossible, Star Trek and 
Indiana Jones – has completed its 

own impossible mission and made over 
100 of its movies available via YouTube. 
It’s a controversial move, but the studio 
has obviously done its maths and figured 
out it can make as much money from 
adverts as it would from DVD sales.

Alas, at the time of writing, the films 
aren’t available in the 
UK, presumably due 
to territorial rights 
issues. However, 
there are other ways 
to enjoy free movies, 
and YouTube is a great place to start. 

While you can find many films by 
searching the video service, these tend to 
be unofficial uploads with varying quality. 
It’s better to head to http://bit.ly/
youtubvid for movies legally uploaded to 
the site. Admittedly quality may vary here, 
but there are some illuminating 
documentaries available – such as Life  
in a Day and First Orbit.

In the UK we may not have access  
to Paramount’s back catalogue – but we 
do have one of the most awesome 
broadcasters on the planet in the form  
of the BBC. Its iPlayer service includes 
movies recently broadcast on terrestrial 
channels (www.bbc.co.uk/iplayer/
categories/films/highlights). At the time  
of writing, Ryan Gosling’s Drive and 
thriller The Disappearance of Alice Creed 
are available on the service, as well as  

a host of BBC4’s 
engrossing 
documentaries.

Where online 
movie-making is 
getting really exciting 

is in crowdfunding sites such as 
Kickstarter. Earlier this year Swedish 
filmmaker David Sandberg released his 
30-minute short Kung Fury via YouTube 
for free. It’s a hilarious, violent and 
hilariously violent homage to 80s action 
movies. You can catch the whole 
30-minute film on www.kungfury.com, 
and see upcoming Kickstarter movies  
at http://bit.ly/upcomfilm.

as Paramount Pictures puts some of its back catalogue 
online, we look at legit ways to find free films for nowt

Steam Controller
At last – a smart clothes iron!
Alas, the Steam in question here is Valve’s 
gaming distribution service and platform. 
And the controller is a device which you 
can plug into your PC and use to play 
games. It’s all part of Valve’s attempt to 
get Steam away from desktops and into 
people’s living rooms.

i already have an Xbox 360 pad for  
that. Why do i need this?
Console-style controllers are great for 
playing console style games on the PC, 
but they’re not so hot when it comes  
to real time strategy and role-playing 
games, which are usually played with  
a mouse and keyboard. The Steam 
Controller aims to solve that.

How will it do that?
A typical controller includes a pair of 
sticks, but the Steam Controller replaces 
these with laptop-style trackpads. These 
work with haptic feedback (vibrations)  
to give you the feeling and precision of  
a mouse in a compact, wireless device.  
It also includes motion sensors so you can 
tilt it to steer in racing games.

it sounds fair dinkum. But how well  
does it actually work?
Early reports are mixed, in truth. Some 
reviewers say they love the idea, but 
others literally can’t get to grips with  
its weird shape. Controllers have been  
an essential part of the console gaming 
experience for almost 30 years, and Valve 
is completely new to this, so it might  
take a couple of iterations before they  
get it completely right.

Hmm, interesting. Well how much  
is it, and when can i get one?
The controllers are out now in GAME 
stores and online via http://store.
steampowered.com/app/353370. They 
cost £39.99, which is about the same as  
a wireless Xbox 360 pad for the PC.

DoWNLoAD click ‘For Windows’ then download 
and run the software. Now open your browser...

tApeD click ‘Download’. if asked, choose ‘Launch’. 
Your program will download to your computer

tV times ...and go to www.bbc.co.uk/iplayer, then 
browse to the program you’d like to download

USe iPlayer offline Watch the BBC anywhere

online movie-making is 
getting really exciting 

thanks to crowdfunding

Discover
The little screen
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HENRY WINCHESTER 

TECH EXPERT

Tip of the month Keep the noise down

Struggling to get something to work? Need a tip? 
Then email us your woes (to windowsmagazine@futurenet.com with the subject line 
‘Windows Insider’) and we’ll share your perfect Windows tweaks in a future issue.

Finding hard-drive hogging programs on 
previous versions of Windows has always 
been a bit of a nightmare, particularly if you’re 
running a small solid state hard drive. 
Windows 10’s storage manager makes 
tracking down overweight apps a lot easier. 
Click the Windows icon, then choose 
‘Settings’. From here, choose ‘Storage’, 
followed by the relevant hard drive. You’ll see 
a lot is taken up by Windows under ‘System 
and reserved’, but clicking on ‘Apps and 
features’ drills down to the most voluminous 
programs. Clicking on one lets you instantly 
uninstall it, freeing up precious space.

Find out which apps 
are taking up the 
most room

There’s nothing quite like a fresh installation 
of Windows, whether it’s on a brand new  
PC, or if you’re just refreshing your ageing 
one with a reinstallation. But tracking down 
and installing all your favourite programs can 
quickly turn pleased wows into frustrated 
groans. Fortunately, Ninite (www.ninite.com) 
is on hand. This simple site lists lots of free 
popular programs – such as Google Chrome, 
AVG, Skype and VLC – and then sticks them 
all in a custom installer. It’s beautiful in its 
simplicity, and we estimate that it’s saved  
us at least a million man-hours of watching 
installation bars slowly fill up.

Ninite

Microsoft’s Kinectimals game was initially 
developed for the Xbox 360’s Kinect 
accessory, but it’s since grown into its own 
franchise – and you can download the 
Windows version for free. Search the store  
for Kinectimals Unleashed and you’ll be able 
to play with cute and cuddly virtual animals. 
It works a little like the Tamagotchi toys of 
yore, with your pets requiring attention and 
love. There are 85 animals to choose from, 
including baby tigers, bear cubs and 15 cute 
puppies. It’s fun and family friendly, and it 
becomes surprisingly rewarding if you play  
it for long enough.

Kinectimals Unleashed

Windows’ libraries are a fantastic way 
to keep lots of files at your fingertips 
– even if they’re stored in different 
folders or drives. The operating system 
includes libraries for Documents, 
Music, Pictures and Videos, and files 
found here can be sorted by date or 
filename. It’s easy to add new places  
to existing libraries, too – simply 
right-click on the relevant folder icon, 
then choose ‘Include in library’ and 

choose the library. You can even create 
a new library for, say, games, or photos 
of a particular person or thing. Click 
the Start button, then click on your 
name in the Start menu. In the left 
panel choose ‘Libraries,’ then click, 
‘New library’. Now click the new icon 
and choose ‘Include a folder’ and 
browse to the folder you’d like to 
include. Keep adding folders to build 
your new library.

Make the most of libraries
Access all your favourite files quickly and easily  
with this oft-overlooked Windows 7 feature

Add librAries libraries are a great way of organising  
and viewing all your PC’s files quickly and simply
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M
icrosoft is about to do 
something unheard of 
– manufacture a PC. The 
Surface Book is a two-in-one 

device powered by state-of-the-art 
components and Windows 10. But is it too 
little, too late for Microsoft?

The company has always had a hand in 
the world of hardware. Its first physical 
product, released in 1982, was a mouse to 
use with Word for DOS. From here 
Microsoft has branched out into other 
accessories, such as keyboards, game 
controllers and webcams. It successfully 
moved into console gaming in 2001 with 
the release of the 
Xbox, and 
entered the 
tablet market in 
2012 with its 
Surface devices.

The Surface 
Book continues 
the evolution of 
these Surface 
tablets. It includes a detachable keyboard 
and a 13.5-inch touchscreen, so you can 
switch between using it as a laptop and a 
tablet. What differentiates the Book from 
other Surface devices is the choice of 
high-end components – the Book’s Intel 
Core i5 or i7 processor, 16GB of memory 
and optional dedicated graphics chip 
elevate it to the same league as high-end 

laptops from companies such as Dell, 
Lenovo and even Apple.

But Microsoft might have an uphill 
struggle on its hands. Five years ago a 
high-end laptop would have turned heads 
and generated profits. Now PCs are part 
of a flooded market, with Google’s cheap 
Chromebooks proving versatile, and 
Valve’s Steam Machines demonstrating 
you don’t need Windows to play games on 
a computer.

Cost analysis 
There’s also the price. The most basic 
Surface Book will set you back $1,499 

(£970), but 
crank up the 
components  
to their highest 
level and you 
can expect  
to spend an 
eye-watering 
$3,199 
(£2,070). It’s 

almost identical to Apple’s pricing of its 
MacBook Pro premium laptops.

Microsoft’s branding still counts for a 
lot, and we’ve always found the company’s 
hardware hardy and well-designed. If 
you’re in the market for a new premium 
laptop you could do far worse than the 
Surface Book – and it could just be the 
shot in the arm Microsoft needs.

The tech giant finally leaps into the world of computing 
with the launch of its Surface Book laptop

Surface tension

1Games company 
Valve is moving into 

hardware – but what was 

its first game?
A. Halo
B. Doom
C. Half-Life

2Which tech company 

is pinning its hopes 

on a Priv smartphone?

A. HTC
B. Yahoo!
C. BlackBerry

3 What is the name  

of the current CEO  

of Microsoft?
A. Satya Nadella
B. Steve Jobs
C. Robert De Niro

4 Which supermarket 

is the one behind 

the creation of budget 

tablet Hudl?
A. Sainsbury’s
B. Lidl
C. Tesco

5 In which city are 
Facebook and 

Google’s European 

headquarters located?

A. Dublin
B. London
C. Bristol

6 What is the name  

of Google’s new 

umbrella company?

A. Umbrella
B. The Googlest
C. Alphabet

Pens at the ready, your time starts now!The 60-Second Quiz

Answers 1C. 2C. 3A. 4C. 5A. 6C.

Microsoft makes a PC Techradar How To
techradar.com/how-to

Techradar.com – which is made by the 
same people as this very magazine – has 
become a hugely successful website 
about all things tech, carrying news, 
opinions and reviews of the latest 
hardware. It’s just got a little bit better, 
too, thanks to its How to subsection.
 This collection of tips and tricks for  
all things tech currently includes advice 
on how to get more from Windows 10, 
tidy up your iPhone’s home screens, take 
stunning photos of wildlife, speed up your 
PC, and use virtual desktops and 
overclock your computer’s memory.  It 
also includes more humorous articles, 
such as how to live as if you’re in Back to 
the Future’s 2015 – as it was imagined from 
the 1989 film. If you want to get more 
from your tech it’s worth bookmarking 
and visiting regularly, and it’s suitable for 
everyone from technological beginners  
to computing professionals.

How do you do?  The tech world’s biggest 
news and reviews are on this website

Discover
It’s good to talk
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Henry Winchester reveals a host  
of fascinating digital facts

TEN  
sEcoNds
The amount of time it 

took hacker Axelle 
Apvrille to access a Fitbit 

activity tracker, at 
Budapest’s Hacktivity 

conference. The tracker 
uses Bluetooth, making it 
vulnerable to ne’er-do-

wellers. Apvrille increased 
the victim’s activity stats 

via the backdoor, 
meaning it’s potentially 
the first virus to cause 
people to gain weight.

What  
is XG.fast?

While it may sound like SlimFast for 
gamers, XG.fast is BT’s experimental 

superfast broadbad technology. It promises 
blazing speeds of up to 5.6Gbps, but the 

crucial part of the new tech is that it can use 
existing copper telephone lines, so there’s no 

need for BT to take the costly steps of upgrading 
its infrastructure to fibre optic cables. At  

the moment it can only achieve the ultrafast  
speeds over runs of less than 100 metres,  

but BT is working on it.

Could you go a day without 
the internet?

If the very idea sends shivers down your spine you’re not 
alone – 36 per cent of Britons surveyed by Vodafone said 

they’d be unable to go for 24 hours without a connection to 
the world wide web. And 69 per cent of those surveyed cited 

boredom as the main reason for their internet addiction. 
Londoners were least likely to try going cold turkey for a 

day, while the east of England was the most up for it.

10  |    |  Christmas 2015

nine  
million…

Gamers took part in the beta test for 
EA’s Star Wars: Battlefront. The 

shooter is set in the popular film 
franchise’s universe, and it invites 

players to step into the shoes of the 
heroic rebels or the evil empire. The 
snowy landscape of Hoth, from The 

Empire Strikes Back, formed the 
backdrop for the beta test, a period 

which is used to iron out  
wrinkles and gauge the game’s 

reception. Early reports are good  
– the force may be strong  

in this one.



what are the  
most photographed 

things on google 
photos?

Google’s photo storage service welcomed  
its 100 millionth user and celebrated with  
a peek behind the scenes. Weddings are  
the most photographed events, followed 

by concerts and Christmas. Dogs are 
the most snapped animals. The 

most photographed places  
are Paris, New York  

and Barcelona.

The blogging site was launched in 2007  
by David Karp and Marco Arment.

Its name is an abbreviation of ‘tumblelogs’  
– short-form blogs which can includes images, 
videos and links.

Tumblr drew inspiration from two existing 
tumblelogs – Anarchaia and Projectionist – 
combining ideas from both in a simple and 
easy-to-use platform.

Within two weeks of launch the site had some 
75,000 users.

In June 2012, paid advertising was launched  
on Tumblr, in conjunction with an Adidas 
campaign – a significant step.

Internet portal Yahoo! bought Tumblr for  
$1.1 billion, netting Karp $250 million.

...but some users were unhappy with the deal.  
A petition against the purchase attracted over 
170,000 signatures.

Regardless of the purchase, Tumblr snowballed 
and it now has 122.4 billion posts across 259.9 
million blogs.

And 14 per cent of 18-29 year olds in the US 
have a Tumblr account.

The most popular blog on the whole of  
Tumblr is mcupdate.tumblr.com, which details 
Minecraft’s latest updates.

top tumblr FaCts 

So
ur

ce
s:

 w
ik

ip
ed

ia
.o

rg
, b

uz
zf

ee
d.

co
m

, t
um

bl
r.c

om
, d

ai
ly

do
t.c

om

17% 
11% 
9% 
8% 
6% 

Source: Forbes/Statista/The Harris Poll

rock out with  
wireless speakers

snuggle up with a  
smart thermostat

feel safer with home  
security systems

let robots do their  
cleaning and mowing

are illuminated by  
smart lighting systems

how  
prevalent is  

smart teChnology  
in us homes?

Discover 
Facts & figures
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According to charity Go ON UK, people living in Greater London have the best IT skills  
– 84 per cent of residents in the Big Smoke know their way around the internet and 
computers. Hot on London’s heels are Scotland, East Anglia and the South East, where 81 
per cent of the population are tech savvy. Broadband-deprived Wales is the worst place 
for IT in the UK – just 62% are said to feel confident when it comes to computers.

whiCh areas oF the uK have  
the best basiC digital sKillsets?



“A lot of useful 
productivity 
features have 
found their  
way into this  
latest release  
of Windows”
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Mayank Sharma shares tips to help you make 
effective use of the new features in Windows 10

 WindoWS 10 
produCtivity  
HintS & tipS

indows 10 is brimming 
with new and updated 
features for streamlining 
all your computing 
tasks. The new release 
combines the familiarity 

of Windows 7 with the functionality of 
Windows 8. It includes all the features 
you have become accustomed to, but 
adds an extra sprinkling of 
customisability, such as the new 
tile-based Start menu. Furthermore, 

plenty of new productivity-enhancing 
features have found their way into this 
release. This is the first version of 
Windows that allows you to divide apps 
and windows between multiple virtual 
desktops, for instance. It also sports a 
new quadrant snapping function that 
allows you to snap up to four windows 
on a screen for enhanced productivity. 

While you can use some features  
to increase your productivity intuitively, 
others require a visit to the menus  

and settings before they can make  
your life easier. In this feature, we’ll  
take you through Windows’ nooks and 
crannies and help you tweak your 
Windows installation to suit your style  
of working. Using the tips, you’ll be  
able to shave time off tasks that need to 
be performed regularly and streamline 
your navigation around the system. We’ll 
also share tips to help tweak the new 
features based on your preferences. 
Let’s get started!

W

1oo
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Windows 10 
100 hints & tips



a better 
deSktop 

1 SCroll inaCtive 
WindoWS

If you often work with multiple open 
windows, then Windows 10 enables you 
to save time by giving you the option to 
scroll through inactive windows in the 
background when you hover over them.
 

2 Snap WindoWS  
to Corner

Windows 10 includes a Snap Assist feature 
that lets you snap two windows side-by-side  
- just drag an open window off screen and 
you are offered a choice of running apps to 
snap next to it. Also, to snap a window to 
a quarter size of the monitor, just drag the 
window to a corner.

3 arrange WindoWS to 
Suit tHe Way you Work 

In addition to Snap, you can arrange 
windows in other ways as well. Right-click 
on the taskbar to reveal three window 
arrangement schemes: namely, Cascade 
Windows, Show windows stacked, and 
Show windows side by side.

4 try out tHe neW Snap 
keyboard SHortCutS 

Use the keyboard to save time and snap 
windows without touching your mouse. 
Use the [Win] key with the arrow key to snap 
an app to one of the four corners of the 
screen and double-up commands to reach 
the quadrants. For example, pressing [Win] 
with the right  arrow, then [Win] with the 
up arrow places the current window in the 
top-right corner.

5 uSe virtual deSktopS
Windows 10 lets you add multiple 

virtual desktops. For this, click the Task View 
button on the taskbar and then click on the 
New desktop button. See Tip 11 if you want 
to hide the Task View button. 

6 peek at tHe deSktop 
Right-click on the thin button at  

the far right of the taskbar (it’s after the date 
and doesn’t look like a button) and choose  
‘Peek at desktop’. Now, when you roll the 
pointer over it, it’ll show you a quick preview 
of the desktop.

8 view apps 
from across 
desktops
By default the taskbar displays 
windows and apps from the 
current desktop. To change this 
behaviour, head to ‘Start > Settings 
> System > Multi-tasking > Virtual 
Desktops’ and select the ‘All 
desktops’ option from the pull-
down menu.

7 Customise 
Quick access
Quick Access allows you to 
immediately jump into your 
favourite folder and most 
recently used files. To customise 
its contents, switch to the View 
tab in Explorer and hit ‘Options’. 
Note that at the bottom of the 
General tab are further  
options to show/hide certain  
bits of information.
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9 Move betWeen  
virtual deSktopS

To move windows between virtual 
desktops, bring up the Task View and drag 
an open window from the current desktop 
straight into the one you want to move 
it into. Alternatively, drag a window to 
the ‘new desktop’ button to create a new 
virtual desktop.

10 get baCk iConS  
on tHe deSktop 

For easier access to certain key locations on 
your computer, head to ‘Start > Settings > 
Personalisation > Themes’.  Next, click the 
‘Desktop icon Settings’ and select the icons 
you want to place on the desktop.

11 Hide tHe taSk 
vieW button

If you don’t use virtual desktops, or use the 
keyboard to switch between them, you can 
banish the Task View icon by right-clicking 
on the taskbar and deselecting the ‘Show 
Task View button’ option.

12 reMove Cortana’S 
SearCH box

Similarly, you can reduce the space taken 
by Cortana in the taskbar, if you don’t use it 
much. Right-click on an empty part of the 
taskbar, select Cortana and choose ‘Hidden’ 
to change it to a pop-up. Keep Cortana on 
the taskbar as an icon by choosing ‘Show 
Cortana icon’.

13 pin and reorder  
your folderS

You can also pin folders in File Explorer’s 
Quick Access list to make sure they don’t 
disappear regardless of their frequent or 
recent use. To change their listing order, 

simply select a folder and drag it above or 
below the other listed folders.

14 CHange tHe default 
vieW in file explorer

File Explorer now defaults to the Quick 
Access view, but if you want it to go 
straight to, say, This PC, on launch, click  
on the View tab, select Options and  
change the ‘Open File Explorer to’ setting  
to ‘This PC’.

15 Make WindoWS 
touCH-friendly

If your computer has a touchscreen you 
can manually enable Windows 10’s  
touch-friendly interface to operate 
Windows in a tablet mode. Head to ‘Start 
> Settings > System > Tablet Mode’  to 
manually alter its behaviour.

17 SWipe Menu
All your apps run full-screen when 

you’re using Windows in Tablet mode. 

To bring up the menu and access any 
commands and the window control, simply 
swipe in from the top.

18 uSe CuStoM inStall
When you’re setting up Windows 

10 on a new PC, make sure you select the 
Custom install option instead of the default 
Express install. It’s more involved but lets 
you modify important aspects of your 
installation, such as the privacy settings.

19 SHake to MiniMiSe 
To declutter your screen you can 

quickly minimise all open windows except 
the one you’re currently viewing. Just click, 
hold and shake its title bar. Repeat the 
action to restore all minimised windows.

20 Mount  
iSo images
You don’t need any third-party 
software to browse the contents 
of an ISO image. Right-click on  
an ISO image and click ‘Mount’. 
The ISO images are auto-
mounted as virtual discs and  
you can then access them from 
the File Explorer.

16 Manage 
notifications
To customise which quick  
action icons are displayed in  
the Notification Center, head  
to ‘Start > Settings > System > 
Notifications & actions’ and then 
click on the four icons displayed 
to select a different icon from a 
pull-down list.
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get going WitH 
tHe Start Menu
21 enable juMpliStS

You can save a considerable amount 
of time by using Jump Lists with your most-
used apps. Open Settings from the Start 
Menu and go to ‘Personalisation > Start’ and 
select the last option to see jump lists on 
your Start Menu and Taskbar. 

22 keyboard- 
friendly Start

You can operate the Start menu almost 
entirely using the keyboard. Hit the 
Windows key to bring it up and then use the 
search feature and arrow keys to navigate it 
without a mouse.

23 ColouriSe Start
The default colour of the Start 

Menu doesn’t please everyone. To pick 
your own colour, head to ‘Start > Settings > 
Personalisation > Colours’ and disable the 
‘Automatically pick an accent colour from 
my background’ option. You can then pick 
an accent colour from the palette.

24 StreaMline Start
If you don’t want the Start menu to 

show the most-used programs in the upper 
left-hand side, open the Settings app from 
the Start Menu and head to ‘Personalisation 
> Start’. Set the ‘Show most used apps’ 
option to ‘Off’.

25 Hide reCently  
opened appS 

If you don’t want the Start Menu to show 
your recently opened programs and files, 
head to ‘Settings > Personalisation > Start’ 
and toggle the ‘Show recently added apps’ 
option to ‘Off’.

27 Stop an app appearing 
in ‘reCently uSed’ liSt

You can also prevent particular apps from 
showing up in the recently used apps list 
(despite how frequently you use it) without 
turning off the feature entirely. To do this 
right-click on an app and select ‘Don’t show 
in this list’.

28 turn off live tileS
If you’re distracted by the constant 

updates and changes in the tiles, you can 
turn off their ability to display updates. Just 
right-click on them and select the ‘Turn live 
tile off’ option.

29 SWitCH to Start SCreen
If you wish to pin more items to the 

Start menu you can actually make it stretch 
across the entire screen. Head to ‘Start 
> Settings > Personalisation > Start’ and 
toggle the ‘Use full-screen Start when in the 
desktop’ option.

30 pin MoSt uSed SettingS
You can pin shortcuts, files and 

folders to Start Menu. Just right-click on 
a chosen item and select the ‘Pin to Start’ 
option. This will immediately pin the item to 
the right-side of the Start menu.

31 alter naMeS and iConS  
of tHe tileS

Right-click on a tile of a non-Modern app 
and select the ‘Open file location’ option. 
This will open the Programs folder. Press 
[F2] to rename the shortcut. To change its 
icon, right-click on the shortcut and head to 
‘Properties > Change Icon’.

31 reMove tileS
On the other hand, if you have  

no use for the tiles on the Start menu  
you can remove every one of them by  
right-clicking on each and selecting the 
‘Unpin from Start’ option.

33 reSize tHe Start Menu
To make room for your 

customisations, you can easily resize  
the Start menu to your liking. Just move 
your mouse pointer to the top-border  
or right-border of the Start Menu, the 
pointer will change into arrows and you’ll 
 be able to increase or decrease height  
and width.

26 Choose 
your folders 
Open the Settings app from Start 
Menu and go to ‘Personalisation 
> Start’ and click on the ‘Choose 
which folders appear on Start’ 
link. Now you can customise the 
folders list that shows on the 
Start menu.
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34 uninStall appS froM  
tHe Start Menu

You can right-click on any Modern or  
traditional desktop app in the Start menu 
and then select the ‘Uninstall’ option from 
the pop-up menu to remove that app 
from your PC.

35 run app aS adMin
If you want to run installed  

apps with escalated privileges for more 
freedom, right-click on them and select  
the ‘Run as administrator’ option. 
Remember, however, this facility is 
available only for regular apps and isn’t 
available for Modern apps.

36  uSe tHe poWer  
uSer Menu

The new Start menu doesn’t bring back 
Control Panel to the menu list, but you’ve 
still got the power user menu from 
Windows 8. Right-click on the Start icon or 
hit [Win]+[X] to bring it up.

37 Sign out of WindoWS
The Power section in the Start  

menu only includes options to Shutdown 
and Restart the computer. To sign in as a 
different user bring up the Start menu and 
click on your name displayed at the top. 
This brings up a menu that includes the 
Sign out option.

39 find apps faster
After click ‘All apps’ in the Start menu you can avoid scrolling through the 
alphabetically arranged list of apps, by clicking on a letter to view the 
alphabet. Now click any letter that takes you directly to the apps grouped 
underneath it.

40 new 
action Center
Windows 10 includes a new  
Action Center that keeps track of 
notifications from all over the 
system. Click on the text bubble 
icon in the system tray and the 
panel flows out from the right- 
hand side of the screen.

38 label and 
group tiles
By default, the Start menu 
arranges tiles inside two groups. 
Click on these labels to rename 
them. If you’ve pinned tiles of 
your own, hover over the area 
above them and click on the two 
parallel lines to name the group.
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WindoWS 
appS
41 print to pdf

You can now save documents as 
PDFs without any third-party software as 
both the Modern apps and the traditional 
desktop programs offer the option as part 
of their standard printing options.

42 Mail geStureS
The new Mail app in Windows 10 

supports a couple of gestures for common 
tasks. Click on the gears icon in the app 
to bring up the Settings and switch to the 
‘Option’ section. Now enable the ‘Swipe 
actions’ option and use the menu to define 
actions for the left and right swipe gestures.

43 Make Cortana  
reSpond to voiCe

For hands-free operation, click on the 
Cortana search bar, select ‘Notebook’ from 
the left menu, choose ‘Settings’, and enable 
the ‘Let Cortana respond to “Hey Cortana”’ 
option. Now repeat the phrase at any time 
to activate Cortana.

44 Make Cortana  
reSpond only to you

You can now ask Cortana to respond only to 
your voice. Head back to the Settings in the 
Notebook and press the ‘Learn my 
 voice’ button and say the phrases so 
Cortana can recognise your voice.

45 Cortana natural  
language SearCH

Since Cortana understands natural 
language you can use it for complex  
search tasks. For example, ask Cortana  
to “Find pictures from August” and  
it will rummage through your local  
and online files and apply filters to  
fetch results.

48 Send an eMail  
WitH Cortana

You can also use Cortana to send an email 
hands-free. Say “Send an email to [Name]” 

followed by the message. Cortana will 
search for the name in the People app and 
compose the email using your spoken text. 
If you don’t wish to make any changes, just 
say “Send”.

49 Manage ContaCtS
A contact in the People app can 

include an email address, work/home 
address and more. And depending on  
what information has been added to the 
contact, you can use the app to launch a 
Map view of the address or compose an 
email to the contact.

50 Cortana in  
tHe edge broWSer

Cortana can also help you as you browse 
the web. To enable it in Microsoft Edge, go 
to ‘Settings > Advanced Settings >View 
Advanced Settings’ and under ‘Privacy and 
Services’ enable ‘Have Cortana Assist Me in 
Microsoft Edge’. 

46 Offline 
maps
Save time and money when 
searching for directions on the 
go by downloading an offline 
version of a map. Head to ‘Start > 
Settings > System > Offline Maps’ 
and then click the ‘Download 
maps’ button. Now you can drill 
down to the geographic region 
you’re interested in to download 
the map.

47 Share your 
preferences 
with Cortana
You can receive better 
recommendations if you let 
Cortana know your preferences. 
For example, open Cortana’s 
Notebook and head to ‘Eat & 
Drink’ to define your choice  
of cuisine, price range and  
more. Repeat the process for 
other sections.
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51 edge reading 
enHanCeMent

Edge has a distraction-free view for 
reading web pages that you can switch to 
by clicking on the Reading View icon (or 
[Ctrl]+[Shift]+[R]). To configure the Reading 
View head to Settings and scroll down to 
the Reading section.

52 Move pHotoS froM 
your pHone

Plug your Android/iOS phone to your 
Windows 10 computer using the regular 
microUSB cable. This will launch the new 
Phone Companion app with information 
about your phone. Now scroll and select 
the ‘Import photos and videos into the 
Photos app’ option.

53 SeleCtively SynC 
folderS WitH onedrive

OneDrive is now more flexible and user-
friendly. To customise the folders it syncs, 
right-click on the OneDrive icon in the 
notification area, select Settings, switch 
to the ‘Choose folders’ tab, and click the 
‘Choose folders’ button to select the cloud 
folders that you want available locally.

54 aCCeSS fileS reMotely
Under the OneDrive Settings tab, 

if you toggle the ‘Let me use OneDrive to 
fetch any of my files on this PC’ option, 
you can access your files from another 
computer using the OneDrive website.

56 enable neW featureS  
in CoMMand proMpt

The new Command Prompt in Windows 10 
allows you to use [Ctrl]+[C]/[V] to copy  
and paste commands more easily. To 
activate the feature, open the Command 
Prompt, right-click its title bar and select 

Properties. From there you can find and 
enable the new features under the ‘Edit 
Options’ section.

57 reCord a video  
of an app

You can now use Windows 10’s Game 
DVR function to record video of any open 
app or desktop software. Press [Win]+[G] 
to open the game bar that has a circular 
Record button. Recorded videos are saved 
under ‘Video > Captures’ folder. Note 
that recording may slow performance 
depending on the demands of the app. 

58 autoMatiCally  
baCkup librarieS

To back up your libraries, plug in an external 
drive and head over to ‘Start > Settings > 
Update & Security > Backup’. Click on the 
‘Add a drive’ option and select the plugged 
in drive and then enable the option, found 
under ‘File History’. 

59 aCCeSS previouS  
verSionS of fileS 

Once you’ve set up the File History 
preference, you can right-click on any file, 
select ‘Properties’, and open the ‘Previous 
Versions’ tab to see past revisions to the  
file saved by either File History or  
Windows’ system restore points.

60 edit and 
share photos
You can use the built-in Photos 
app to fix many common photo 
flaws. You can straighten and 
sharpen images and apply  
filters and effects. If you have 
installed social apps such as 
Facebook or Twitter you can use 
Photos to share images with 
friends and family.

55 Contact 
Support
If you need help setting up  
a Windows app or are facing 
any issue, you can use the 
Contact Support app under  
the ‘Start > All apps menu’. The 
app will help you find 
discussions relevant to your 
technical problems on the 
community forums.
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SettingS  
& tWeakS
61 bypaSS tHe  

Sign-in SCreen
Make booting up quicker by logging 
straight into Windows. Type netplwiz in the 
search bar to bring up the User Accounts 
window. In the Users tab, deselect the ‘Users 
must enter a username and password to use 
this computer’ option.

62 analySe available  
Storage SpaCe

To figure out what kind of files are taking 
up room on your computer, head to ‘Start 
> Settings > System > Storage’ and click on 
the drive name to get a breakdown of how 
the space is being used.

63 Save appS to  
external driveS

If you use an SSD as your system drive 
you can ask Windows 10 to install apps on 
another disk by heading to ‘Start > Settings 
> System > Storage’ and pointing to it under 
the ‘New apps will save to’ option.

64 CuStoMiSe your default  
app aSSoCiationS

If the default file associations don’t  
work for you, you can change them by  
right-clicking on a file and selecting the 
‘Open with’ option. Now select the ‘Choose 
another app’ option and pick the app you 
wish to use.

65 define keyboard 
SHortCut for appS 

To get faster access to apps, you can launch 
them by using custom keyboard shortcuts. 
For this, right-click on an app’s icon and 
head to ‘Properties > Shortcut’. Now click 
inside the text box labelled ‘Shortcut key’ 
and press any key.

66 Set diSplay for  
eaCH Monitor

With Windows 10 you can configure 
different DPI scaling ratios if you’ve  
got multiple monitors attached to  
your computer. Right-click on the  
desktop and head to ‘Display settings’,  
which lets you configure each detected 
display individually.

67 diSable Wi-fi SenSe
If you’re worried about Wi-Fi Sense’s 

security implications you can disable it by 
heading to ‘Start > Settings > Network & 
Internet > Wi-Fi > Manage Wi-Fi settings’. 
Now disable all options and ask Windows 10 
to forget any Wi-Fi networks you’ve signed 
into in the past.

68 CuStoMiSe tHe  
battery Saver

The Windows 10 Battery Saver  
clamps down on background activities in 
order to maximise your system’s battery.  
You can enable it from under ‘Start > 
Settings > System > Battery Saver’. It comes 
online automatically when the charge drops 
below 20%.

69 ’god Mode’
God Mode is a one-stop panel 

that gathers all Control Panel commands 

70 Customise 
Sync settings
You can easily take charge of  
the settings that synced from  
the current installation to your 
online account. Head over to 
‘Start > Settings > Accounts > 
Sync your settings’ and disable 
any of the listed settings that  
you don’t want to sync with  
your Microsoft account.
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within Windows 10. Create a folder on your 
desktop named: GodMode.{ED7BA470-
8E54-465E-825C-99712043E01C}. Once 
made, the folder will change to the Control 
Panel icon and be rename to ‘GodMode’.

71  uSe MaxiMuM Cpu
You can make sure you are using the 

maximum power of your main processor on 
a desktop PC by heading to ‘Control Panel > 
Hardware and Sound > Power Options. Here 
click Change Advanced Power settings > 
Processor power management > Minimum 
processor state’ and change it to 100%.

72  CuStoMiSe your  
app notifiCationS 

Notifications from all the installed apps can 
make you miss the real important ones. To 
curb notifications head to ‘Start > Settings > 
System > Notifications & action’. Scroll down 
and selectively turn off apps that you don’t 
want to hear from.

73  no autoMatiC updateS
By default some Windows updates 

will automatically restart your computer to 
finish installing. To put yourself in charge, 
head to ‘Start > Settings > Updates and 
Security > Windows Update > Advanced 
Options’. Under the ‘Choose how updates 
are installed’ pull-down menu, select the 
‘Notify to schedule restart’ option.

74 SCHedule reStartS 
To continue working uninterrupted, 

you can ask Windows 10 to delay applying 
an update that requires a restart. Head to 
‘Start > Settings > Updates & security’. If you 
have an update pending, you can schedule 
your reboot after selecting the ‘Select a 
restart time’ radio button.

75 get updateS froM  
otHer SourCeS

Windows 10 lets you download updates 
from other computers on the network  
and the internet using peer-to-peer 
technology, rather than Microsoft directly. 
To tinker with the setting, head to ‘Settings 
> Update & Recovery > Windows Update 
> Advanced Options > Choose’ how you 
download updates.

76 reMove old fileS
If you have no intentions of reverting 

to the previous version of Windows, you can 
save disk space by getting rid of the old OS 
files. Head over to ‘Control Panel > System 
and Security > Administrative Tools > Disk 
Clean-up’ and toggle the ‘Previous Windows 
installations’ box in the list.

79 Setup Metered 
ConneCtionS

If you are connected to a mobile Wi-Fi 
hotspot, you might want to configure it 
as a metered connection to restrict your 
data usage. Head over to ‘Notifications 
> All settings > Network & Internet > 
WiFi > Advanced options’ and under 
‘Metered connection’ enable the ‘Set as 
metered connection’ option.

80 unloCk your pC 
WitH a fingerprint

Windows 10 includes a suite of new 
biometric security features known as 
Windows Hello. If you have the required 
hardware then you can use fingerprint 
detection or face recognition to log in. 
Head to ‘Start > Settings > Accounts > 
Sign-in’ options to explore the various 
available options.

78 find  
the original 
Control 
panel
The new Settings panel  
is easy to navigate and is 
easier to navigate than the 
old Control Panel. But the 
latter is still available and 
comes in handy for accessing 
advanced options. You can 
find it under the [Win]+[X] 
power user menu.

77 Customise 
privacy 
settings
To take charge of general and 
app-specific privacy options 
head over to ‘Start > Settings > 
Privacy’. From here you can  
also individually define  
which apps can access the 
connected hardware like 
Cameras and microphones. 
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81 Slide doWn tHe 
deSktop to SHutdoWn

Head to ‘Windows > System32’ and double-
click on the slidetoshutdown.exe program. 
Performing this action from now on will 
drop in your lock screen image from the top 
and cover half of your screen. Just slide the 
image to the bottom of your screen to shut 
down your computer. 

82 generate a  
battery report

If you want to keep tabs on your laptop’s 
battery level, launch the Administrative 
command prompt and type the following 
command powercfg -energy -output C:\
report.html. The command will analyse the 
battery status and create a Power Efficiency 
Diagnostics Report in the root directory of 
the C: drive. 

83 diSable data 
ColleCtion

To prevent your computer from 
communicating with Microsoft HQ, type 
services in the Start menu search bar 

to bring up the Services Management 
console. Now find and disable the services 
named ‘Diagnostics Tracking Service’ and 
‘dmwappushsvc’. You’re done.

84 iMproved regiStry 
editor

If you use the Registry Editor, Windows 10 
now lets you navigate the quintessential 
power user app with ease. You can now 
jump between the same entries under 
the HKEY_LOCAL_MACHINE and HKEY_
CURRENT_USER hives using a special 
context-menu entry.

85 Create a reCovery diSC
Plug in a USB drive and head to 

‘Start > Settings’ and type recovery in the 
Find a setting textbox and select the ‘Create 
a recovery drive’ option. This will launch 
a wizard which wipes the USB drive and 
transforms it into a recovery drive.

88 Create a SySteM iMage
Head to ‘Start > Settings’ and type 

file in the textbox and select the ‘File History’ 

86 Side load 
Windows 
apps
Just like Android, Windows 10 
now lets you install Windows 
apps from other sources besides 
the Windows Store. To enable 
this action, simply head over to 
‘Start > Settings > Update & 
security > For developers’ and 
click the ‘Sideload app’ option. 

87 decrease 
effects
If you are running Windows 10 on 
a resource strapped machine, 
you can squeeze more 
performance by turning down 
the bling. Head to ‘Control Panel 
> System and Security > System’ 
and click ‘Advanced system 
settings’. Now click ‘Settings’ 
under the Performance section 
and customise the effects.

advanCed 
triCkS 
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tool. Click the ‘System Image Backup’ link 
in the lower-left corner to start a wizard; 
this lets you select the destination drive for 
storing the backup image.

89 reStart explorer
To quickly apply changes that require 

restarting the computer, launch the Task 
manager by right-clicking on the taskbar. 
Click the ‘More Details’ button and under 
the ‘Processes’ tab look for an entry named 
‘Windows Explorer’. Then right-click on it 
and select ‘Restart’.

90 CHange tHe loCation 
of edge’S doWnloadS

To force the Edge browser to use a  
custom Downloads folder, head to 
the Registry Editor and navigate to 
HKEY_CURRENT_USER\SOFTWARE\
Classes\Local Settings\Software\
Microsoft\Windows\Current Version\
AppContainer\Storage\microsoft.
microsoftedge_8wekyb3d8bbwe\
MicrosoftEdge\Main key. Create a new 
String named ‘Default Download Directory’ 
and set its value to the path of the new 
folder, such as D:\Downloads.

91 StreaM Media aCroSS  
tHe netWork

Go to ‘Control Panel > Network and Internet 
> Network and Sharing Center’ and click on 
‘Change advance sharing settings’. Then go 
to All Network section and click the ‘Choose 
media streaming options’ link and turn on 
media sharing.

92 StreaMline tHe  
navigation pane

To remove the OneDrive link in Windows 
Explorer launch the registry editor and head 
over to the key: HKEY_CLASSES_ROOT\
CLSID\{018D5C66-4533-4307-9B53-
224DE2ED1FE6}. Then in the right-side 
pane, change the value of the System.
IsPinnedToNameSpaceTree variable to ‘0’.

96 disable 
new battery 
flyout
To bring back the old battery 
display in the taskbar, head to 
the HKEY_LOCAL_MACHINE\
Software\Microsoft\Windows\
CurrentVersion\ImmersiveShell 
key in the Registry Editor. Here 
create a new DWORD named 
UseWin32BatteryFlyout and set 
its value to 1.

95 Monitor 
with task 
Manager
Windows 10 also includes an 
improved Task Manager with  
a better layout and easily 
digestible information and  
useful graphs. Familiarise 
yourself with the Task Manager 
to monitor the resources of  
your PC and to terminate 
unresponsive processes.

93 Modify WindoWS  
update poliCy

If you want to always be notified of an 
impending Windows update, you can 
change the setting in the Registry Editor. 
Launch regedit and head to the
HKEY_LOCAL_MACHINE\SOFTWARE\
Policies\Microsoft\Windows key. Here create 
a new key under Windows key and set its 
name as WindowsUpdate. Then create 
another new key under WindowsUpdate 
key named AU. Here create a new DWORD 
named AUOptions and set its value to ‘2’. 
Lastly click ‘Check for updates’ in Windows 
Update to bring the changes into effect.

94 reStore tHe previouS 
voluMe Control ui

To bring back the vertical volume lever  
in the system tray, simply bring up the 
Registry Editor and head over to the 
HKEY_LOCAL_MACHINE\Software\
Microsoft\Windows NT\CurrentVersion\ 
key. Then create a new key named MTCUVC 
and under it create a new DWORD named 
EnableMtcUvc and set its value to ‘0’. The 
volume control UI will be restored.

97 Create a loCal 
aCCount 

If you don’t want the benefits of OneDrive 
synchronised account, you can create a 
standalone offline account. Head to ‘Start 
> Settings > Accounts’ and click the ‘Sign in 
with a local account instead’ link.

98 Speed up app  
launCHeS at boot 

On a super-fast machine you can disable 
the artificial app startup delay. Launch 
regedit and navigate to HKEY_CURRENT_
USER\Software\Microsoft\Windows\
CurrentVersion\Explorer. Right click 
Explorer, select ‘New > Key’, and name it 
Serialize. Under this key, simply create a 
DWORD value called StartupDelayInMSec 
and set it to ‘0’.

99 CuStoMiSe tHe poWer 
uSer Menu

To reorganise and or remove entries  
go to ‘C:\Users\<username>\AppData\
Local\Microsoft\Windows\WinX’. Here  
you’ll notice three folders that house  
entries for the Power User menu. You  
can move them around or remove them  
to suit your workflow.

100 enable tHe  
adMin aCCount 

By default, the built-in Administrator 
account is hidden to users. To enable 
it, launch the Command Prompt 
as Administrator and type net user 
administrator /active:yes. Now logout to  
see the newly added Administrator account 
on the login screen.
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Learn how to…
Use OneDrive to store  
your photos and files

“Thanks to Microsoft’s cloud 
storage, the days of plugging  
in fiddly cables are over”

f you’ve taken your first steps 
into the world of  
cloud computing, you might 

already be familiar with Microsoft 
OneDrive. The service, formerly 
known as SkyDrive, is a free tool that 
enables you to store your files online 
and retrieve them through a web 
browser – a little like an extra hard 
drive that you can access anywhere 
remotely. It comes built into Windows 
8.1 and 10, but there’s also a desktop 
app available to download from 
http://onedrive.live.com. 

In the wake of its success on the 
desktop, Microsoft has now launched 
mobile apps that bring all the 
convenience of OneDrive to your 
Android or iOS devices. Not only does 
this enable you to open your files and 
work with them on the move, it also 
enables you to back up photos and 
videos taken on your phone so a 
stolen handset doesn’t mean lost 
memories. Let’s get started!

1 Discover OneDrive
When you installed Windows 10, you will have been asked 

to create a Microsoft account. This account includes access to 
OneDrive; type OneDrive into the Start menu and select the 
desktop app to access your online storage area. You can also 
access your account via File Explorer, and it appears as an option 
when you save a file in any Microsoft Office app.

2 Going mobile
Now you’re familiar with OneDrive, it’s time to move beyond 

the desktop. Windows 10 was created with mobile in mind, so it’s 
easy to access and synchronise files across devices. To begin, type 
companion into the Start menu and select ‘Phone companion’. 
You’ll be prompted to choose your device’s operating system. 
Here, we’re going to set up an Android phone.

Step-by-step One drive for everything

MenU
Tap here to choose the type of files to 
view (photos or other documents), adjust 
your sharing options, and access or 
empty your recycling bin.

AlbUMS
These are a convenient way to group 
photos together and share them with 
your contacts. OneDrive has access to 
your phone’s address book for this 

SeArch
OneDrive gives you lots of free space, so 
sometimes you might need to search for 
what you need. This can be text within a 
document, or tags.

TAgS
OneDrive uses the power of Bing – 
Microsoft’s search engine – to guess the 
subjects of your photos and apply 
appropriate tags to organise them.

I

Your guide Cat Ellis  says…

  Anyone can do it 
Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…
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3 Photo transfer
Once you’ve made your choice, you’ll see the Microsoft 

services available (plus any coming soon). The second option – 
automatically get photos taken with your phone or tablet onto 
your PC – uses OneDrive to transfer your snaps to your desktop; 
no cables required. Select this option, and then verify that you’re 
logged into Windows with your own Microsoft account.

4 Get the app
Now you need to download and install the OneDrive app  

on your phone or tablet. You can do this through your phone’s 
app store, or enter an email address to send yourself a direct link. 
The installation file is 28MB, so it’s best to download it over a  
Wi-Fi connection rather than 4G if you have a limited monthly 
data allowance.

Jargon buster!
 cloud computing

Using online servers 
to store and manage 
your files remotely.

 Android
Google’s operating 
system for mobile 
devices, including 
your smartphones 
and tablets.

 iOS
Apple’s mobile 
operating system, 
used by the iPhone, 
iPad and iPod Touch.

bATTery
Keep an eye on your 
phone’s power level. 
OneDrive uses a lot 
of juice, and your 
photos will stop 
synchronising if  
your battery is 
running empty.

OpTiOnS
Click here to activate 
‘Camera Upload’,  
and to refresh the 
contents of your 
OneDrive to reflect 
any changes  
you’ve made on 
another device.

Explore 
OneDrive
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9 Smarter tagging
Tags are a useful way to categorise photos, but it’s a chore 

tagging photos individually. That’s not a problem with OneDrive, 
which uses Bing’s image-recognition to guess the subject of each 
picture. It’s accurate for the most part (although it’s not infallible 
– in our tests, it tagged a hamster as #cat and #people). Select the 
option just below the search button to try it. 

7 Auto sync
Now close the guide on your PC and open your OneDrive 

folder in File Explorer. Open ‘Pictures’ and you’ll see a folder 
named ‘Camera roll’; this is where all pictures from your phone 
will be stored. If you can see a green tick beside the folder, all your 
pictures have been synchronised. If there are two blue arrows, the 
pictures are currently being updated.

5 Log in
Click the ‘Next’ button on your PC and you’ll be prompted to 

sign into the OneDrive app on your phone using your Microsoft 
account details. Open the app and click ‘Sign in’, then enter your 
email address and password. Once you’ve logged in, you’ll be 
asked whether you want to upload the photos and videos already 
on your device. Tap ‘Not now’.

10 All together now
Congratulations, all the photos taken with your phone will 

synchronise automatically with your OneDrive account! Not only 
can you now access them from your PC, but from any internet-
connected device – including those on different mobile operating 
systems. If you have another smartphone or tablet, installing 
OneDrive on both will combine your snaps into one place. ■ 

8 Album art
When you tap and hold your finger on a photo, a selection 

of options appear in the top bar. One of the most useful is the 
ability to add photos to albums. This not only keeps them  
neatly organised, it enables you to share a collection of  
pictures rather than individual snaps – ideal for pictures from a 
special event.

6 Camera Upload
Back on your PC, check the box labelled ‘I’m signed in to the 

OneDrive app on my phone or tablet’ and click ‘Next’. You’ll now 
be asked to enable Camera Upload on your phone – to do this, 
open the app’s menu, then select ‘Settings > Photos > Turn on’. If 
your phone is connected to Wi-Fi, it will now begin uploading all 
the photos from its camera reel to OneDrive automatically.
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By taking part you agree to be bound by the Competition Rules. Open to UK and Republic of Ireland residents aged 18 and over. The closing date is 11:59pm on 31 December 2015 (GMT). Five winners drawn at random from the correct entries will be entitled to one BB-8 droid each. Specifi cation may vary from pictured 
model. Only one entry per household; multiple entries will be disqualifi ed. No cash equivalent. See www.futureplc.com/competition-rules for full terms and conditions.

Note: BB-8 is controlled by a smartphone app, which is available on Android and iOS. You are responsible for ensuring that BB-8 is compatible with your phone.
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WHAT EPISODE IS STAR WARS: THE FORCE AWAKENS?

A. VII B. VI C. IV

ENTER ONLINE NOW FOR FREE AT

www.futurecomps.co.uk/WIN-BB8

WIN! 
A BB-8 
DROID

T
o celebrate the release of 
Star Wars: The Force 
Awakens, we are giving 
readers the chance to win 

one of five BB-8 droids by Sphero.
With this gadget you can design a 

route for BB-8 and control from your 
smart device. You can also create and 
send holographic videos.

BB-8 will learn to recognise your 
voice, and adapt personality as you 
interact.

Who wouldn’t want one?
All you have to do to be in with a 

chance of owning one of these 
remarkable gadgets is answer the 
following question:
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Learn how to…
Get gaming on 
Windows 10

“Windows 10 adds some welcome new  
features to its gaming repertoire. Discover  
how to set things up to take full advantage”

icrosoft has returned to 
Windows gaming with a 
vengeance in Windows 10. 

It’s upgraded DirectX to version 12, 
which finally allows it to talk to your 
graphics card using more than one 
processor core. This means future 
games supporting DirectX 12 (as  
well as current games updated to 
support it) will run much quicker  
and be more responsive. 

Other improvements centre around 
the new Xbox app, designed to link 
your PC with your Xbox for streaming 
games, reviewing your gaming 
history and staying in touch with your 
mates on the Xbox live platform. You 
can even use it as a remote control 
for your Xbox One’s media content.

These new features are all well  
and good, but there are a few steps 
you should follow to make sure 
Windows 10 is set up for gaming 
heaven – read on to find out what 
you need to know.

1 Upgrade drivers
Windows 10 won’t necessarily have the latest drivers for 

your setup – it’s usually better to install chipset and graphics 
drivers direct from the manufacturer, such as NVIDIA (nvidia.co.
uk) or AMD (amd.com) for graphics. Trouble tracking down the 
latest drivers for your PC? Try a program like Driver Booster Free 
(iobit.com/en/driverbooster.php) to see if it can track them down.

2 Connect controllers
Plug in your game controller if you haven’t already – it 

should be automatically detected and drivers downloaded and 
installed. Once done, type controllers into the Search box and 
click ‘Set up USB game controllers’. Click ‘Advanced’ to choose 
which controller to use with older programs, and ‘Properties’ to 
verify your controller is working correctly (and calibrate it if not).

Your guide Nick Peers says…

M

NICK’s best tiP
Download X360CE from  
http://bit.ly/1GfL8WO to use 
your controller as an Xbox 360 
controller for certain games.

Step-by-step Make Windows 10 gaming friendly

  Anyone can do it 
Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…

30  |    |  Christmas 2015



7 Go Xbox
Windows 10 introduces a new app called Xbox, which it 

hopes will eclipse Steam for gaming. Log in with your Microsoft 
Account if necessary, then follow the prompts to set up your Xbox 
account. Once done, use the icons down the left-hand side to 
navigate the app, customise your profile, manage your games and 
even connect Windows to your Xbox One console.

8 Game DVR
When playing a game in windowed mode (not full-screen), 

press [Win]+[G] to open the Game bar. From here you can take 
screen snaps and – if your graphics card supports it – record live 
footage of your gaming, which you can then organise, rewatch 
and share with others in the main Xbox app. Configure Game DVR 
via its own tab in the Xbox app’s Settings screen. ■

5 Make Steam your gaming centre
You can add games you’ve installed independently of Steam 

to your library, making it your one-stop shop for gaming in 
Windows 10. To do this, visit your Library page, click ‘+ Add a 
Game…’ and choose ‘Add a Non-Steam Game’. Steam will list all 
installed programs on your PC, so it’s up to you to identify your 
games and tick them, then click ‘Add Selected Programs’.

3 Check compatibility
If you’ve upgraded to Windows 10, check to see if any 

previously installed games still work – if they don’t, visit the 
game’s website to see if a compatibility patch is available or other 
tips for getting the game to work can be found (for example, 
using Compatibility Mode – right-click the program shortcut and 
choose ‘Properties > Compatibility’ to set this up).

6 Replacing missing Windows games
Windows 10 removes the free Microsoft games like Solitaire 

and Minesweeper. Instead, you can download free ad-supported 
versions from the App Store (ads can be removed by buying a 
subscription – £1.19 a month, £7.69 a year). Free alternatives 
include 123 Free Solitaire (www.123freesolitaire.com) – use a 
website such as alternativeto.net to help you find them.

4 Get Steam
If you’re a Steam user, visit store.steampowered.com and 

click ‘Install Steam’. Download and install the main program, then 
log in with your account (you’ll need to enter a code emailed to 
you to verify this computer). Once logged in, right-click the 
program’s new taskbar notification area icon to download and 
restore previously purchased games or access your library.

Explore 
Get gaming on Windows 10

Christmas 2015  |    |  31



     

Subscribe to our print edition, digital 
edition, or get the best value with  
our complete print and digital bundle

Print SubScriPtion  
only £48

(for 1 year) 

Every issue delivered to your door  
at a fraction of the cost

digital SubScriPtion 
only £20

(for 1 year) 

instant digital access on your  
iPad, iPhone and android device
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Switch view
Click these buttons to move 
between viewing available, 
installed and hidden 
updates, plus review your 
update history.

controlS
These perform 
the following 
actions: check for 
updates, 
download only, 
install, remove, 
hide/unhide and 
copy to 
clipboard.

Update 
repoSitory
Choose which 
update repository to 
search – in most 
cases the ‘Default’ 
choice is best.

Learn how to…
Use windows 
Update

“Discover how to tame the worst  
excesses of Windows Update and  
regain control of your PC”

he new Windows Update 
mechanism in Windows 10 
has been rigidly designed. 

While there’s good reason to ensure 
critical security patches and fixes are 
installed automatically, some 
Windows 10 users have already 
suffered from Microsoft’s over-
zealous policy of forcing updates 
before those updates have been 
properly tested.

Thankfully, there are some ways in 
which you can regain control of how 
Windows Update operates – 
particularly if you’re a Windows 10 
Pro user. But even if you’re stuck with 
Windows 10 Home, where it’s 
impossible to change the automatic 
setting, there are still tips, tricks and 
tools you can use to regain some 
control and make more from 
Windows Update. In this tutorial we’ll 
reveal everything you need to put 
Windows Update back in its place.

1 Basic settings
Click ‘Start > Settings > Update & Security > Windows 

Update’ to check for updates. Click ‘Advanced options’ to change 
how updates are installed – if you select ‘Notify to schedule 
restart’ you’ll be prompted whenever updates have been 
downloaded and installed. You can also opt to receive updates for 
other Microsoft products like Office here – just tick the box.

2 Defer updates
Windows 10 Pro users can postpone non-essential updates, 

giving time for any bugs to be discovered and ironed out. Tick the 
‘Defer upgrades’ box to enable this – you’ll effectively be switched 
to the ‘Current branch for Business’, which means only essential 
security updates are installed immediately; others will be deferred 
until they’ve been more thoroughly tested (by Home users).

Your guide Nick Peers says…

T

Step-by-step Configure Windows Update

 Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

at a glance
Skill level…

Suitable for…
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view UpdateS
All applicable 
updates based on 
your viewing choice 
are displayed here. 
Tick the box next to 
each to select them.

More info
Roll the cursor over an 
update to reveal this 
popup providing a 
detailed description.

configUre UpdateS
Click here to tweak automatic 
updates in Windows 10 Pro 
after you’ve followed step six 
of the guide.

3 Control how updates are delivered
By default, Microsoft will use your PC to share updates with 

other computers, which will sap internet speed and use up any 
monthly allowance you may have. Click ‘Choose how updates are 
delivered’ to change this – flick the main switch to ‘Off’ if you only 
have one Windows 10 PC on your network, or choose ‘PCs on my 
local network’ to reduce internet usage in a multi-PC household.

4 Trick Windows Update
If you connect through a wireless connection, you can delay 

updates by claiming you’re on a metered connection – click ‘Start 
> Settings > Network & Internet > WiFi’ and click ‘Manage WiFi 
settings’. Flick the ‘Metered Connection’ switch to ‘On’ and updates 
won’t be delivered until you switch it off. Set an alarm to remind 
yourself to flick it off periodically to check for updates manually.

Nick’s best tiP
O&O shutUp (oo-software.
com/shutup10) is a privacy 
tool that also allows you to 
tweak Windows Update.

Jargon buster!
.7z file
A compressed file 
similar to zip files. 
Support isn’t built 
into Windows, so a 
third-party app is 
required to extract 
its contents.

group policy editor 
(gpedit.msc)
A Windows 10 
Pro-only tool that 
allows users to 
configure various 
administrative and 
security settings 
without editing the 
Registry.

System type
The version of 
Windows – 32-bit or 
64-bit – that is 
currently running. 
Right-click ‘Start’ and 
choose ‘System’ to 
find this out.

Explore 
Use Windows Update
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9  Launch app
Open the en_wumt folder and double-click wumt_x64.exe 

if you’re running the 64-bit version of Windows, or wumt_x86.exe 
for the 32-bit version to launch the app. You’ll see a two-paned 
window appear with options on the left. Use the annotation on 
the previous page to help identify key parts of the program, then 
click the ‘Check for updates’ button to review available updates.

7 Manage updates with MiniTool
Windows Update MiniTool is a portable app that gives you 

more control over viewing, managing and hiding updates. It’s 
delivered in a .7z file, which can be extracted using a free program 
called 7-Zip – download and install it from www.z-7ip.org. Once 
done, browse to http://bit.ly/winupdmini and click the en_
wumt.7z icon to save it to your Downloads folder.

5 Disable automatic driver updates
By default, Windows Update updates supported hardware 

devices too – if you’d prefer to manage this yourself, right-click 
the Start button and choose ‘System’. Click ‘Advanced System 
Settings’, switch to the Hardware tab and click ‘Device Installation 
Settings’. Select ‘No, let me choose what to do’ followed by ‘Never 
install driver software…’ and click ‘Save Changes’.

10 Manage and tweak
Roll your mouse over an update for a more detailed 

description, or select it and click the ‘Update Support URL’ to see if 
a Knowledgebase article can provide more information. You can 
hide any unwanted non-critical updates from view. Download 
and install individual updates from here, plus review installed and 
hidden updates, plus your update history using the controls. ■

8 Extract and run
Open Z-Zip File Manager from ‘Start > All Apps > 7-Zip 

menu’. Click ‘Computer’, then browse to your Downloads folder 
(typically C:\Users\<username>\Downloads), select en_wumt.7z 
and click ‘Extract’. Remove the trailing \en_wumt from the ‘Extract 
to:’ box and click ‘OK’. Once the files have been extracted, close 
7-Zip and navigate to your Downloads folder in File Explorer.

6 Disable automatic updates
Pro edition users should type ‘gpedit’ into the Search box 

and click ‘Edit group policy’. Expand ‘Administrative Templates > 
Windows Components’ under ‘Computer Configuration’ and select 
‘Windows Update’. Click ‘Configure Automatic Updates’ in the 
right-hand pane, select ‘Enabled’ and then pick option 2 or 3 to 
force Windows to wait for your say so before installing updates.
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Learn how to…
Get the most  
from Cortana

“Microsoft Cortana promises to help you take  
control of your life – discover how to set it up so it 
can do just that with our guide to getting started”

irtual assistants are all the 
rage these days. There’s 
Google Now and Apple’s Siri, 

but loudest of the lot is Microsoft’s 
new Cortana. It’s built right into 
Windows 10 (and Microsoft’s new 
Edge browser), ready and waiting to 
not just help you find things but also 
provide context-sensitive tools when 
travelling, entertaining or working.

Cortana learns what you’re doing 
too, so it can better anticipate your 
needs. Do you regularly travel to 
and from work with your laptop? 
Let Cortana know where those 
places are, and she’ll start to look out 
for traffic news and give you a heads 
up on when’s the best time to leave. 
You can use her to set up meetings, 
create reminders and also provide 
you with tips for your next night out. 
Here’s what you need to do in order 
to get started…

1 Get Cortana working
Click Search and click ‘Settings’. If you’re told Cortana isn’t 

supported in your region and language, click ‘Start > Settings > 
Time & Language > Region & Language’. Set to English (United 
Kingdom), click on English under Languages and choose ‘Options’. 
Click Download under ‘Speech’ – once downloaded, click ‘Settings’ 
and select ‘English (United Kingdom)’.

2 Set up Cortana
Now click ‘Search > Settings’ again and flick the Cortana 

switch to ‘On’. Work through the set-up wizard to configure it. The 
more features you allow, the better Cortana will be (but at the 
expense of some of your privacy). Provide your nickname and 
follow the prompts to settings to switch on the Location service 
and – if necessary – switch to your Microsoft account.

Your guide Nick Peers says…

V

NICK’s best tiP
You need a Microsoft Account 
for Cortana – if you’re logged 
in with a local account you 
can switch during setup.

Step-by-step Get Cortana set up and running

  Anyone can do it 
Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…
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7 Talk, don’t type
If you have a microphone, you can talk to Cortana instead of 

typing – tap the microphone button and follow the wizard to set 
up your microphone for the first time. Then open Cortana’s 
settings and flick the ‘Hey Cortana’ switch to On. Now you can 
grab Cortana’s attention by saying ‘Hey Cortana’ then speaking 
your search terms or command, such as ‘Create reminder’. 

8 Living on the Edge
If you want Cortana to pop up with suggestions while you 

browse using Microsoft Edge, open the browser and click the 
menu (‘…’) button. Select ‘Settings > Advanced settings’, then 
scroll down and flick the ‘Get Cortana to assist me in Microsoft 
Edge’ switch to ‘On’. In addition to suggestions, you can right-click 
words or phrases in websites and choose ‘Ask Cortana’ for help. ■

5 Stay in command
You can type commands to Cortana as well as search terms 

into the ‘Ask me anything’ box – for example, type ‘set up a 
meeting’ and Cortana will ask you for a date, time, subject and 
calendar (from those accounts linked in to the Calendar app) to 
store it in. Once added, type ‘view calendar’ to get an at-a-glance 
look at any upcoming meetings.

3 Integration
Cortana will integrate with your location and online services 

to start providing information such as a local weather forecast. To 
customise this further, click ‘Open Notebook’. Start by clicking 
‘About me’ to set your home, work and other favourite places – if 
you take your Windows 10 device with you when out and about, 
this will help Cortana learn your travel and work habits.

6 Reminders
Click the lightbulb icon to set a reminder. Reminders can  

be linked to times, places and even people – click the + button  
to set up a new one, then enter your reminder into the 
‘Remember to’ box. Desktop users will get the most use out of 
time-based reminders – click ‘time’, then choose a time followed 
by day and whether it’s repeating. 

4 Set up notebooks
Notebooks help Cortana learn about you – they contain 

information about your interests, from news and sport to travel 
and film, as well as your calendar (which links with the Calendar 
app and your Outlook.com calendar). From ‘Notebooks’ click a 
category to switch it on or off, plus tailor it to your personal needs 
– for example, price range for food suggestions or news topics.

Explore 
Get the most from Cortana
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Learn how to…
Clean up your PC 
the safe and easy way

“Free download Clean Master can remove caches, 
backups and all sorts of other files that could be 
clogging up your PC’s disk space”

he programs we run on our 
PCs love to use our disk 
space. They leave behind 

caches of files, backups of old 
downloads, working files and folders 
of data with obscure names that give 
no hint to their purpose. 

Much of the time, this isn’t a 
problem. The programs are designed 
to work this way, and their data 
contributes toward their proper 
functioning. But in these days of 
small SSDs, especially when used as 
system drives, every gigabyte can 
count – and this is where cleaning 
programs come in.

CCleaner is a popular choice in this 
area, but here we’re going to talk 
about a relative newcomer to the PC 
cleaning scene: Clean Master. An 
offshoot of a popular Android app, 
Clean Master is a very fast scanner 
that clearly shows the origins of the 
files it’s removing.

1 Install the app
You’ll find Clean Master at www.cmcm.com/en-us/clean-

master-for-pc. Watch the demonstration video if you like, or dive 
in and click the Free Download link. It’s not a large file, so should 
download fairly quickly. Run the installer either from your browser 
or by double-clicking the file in your Downloads folder. You’ll have 
to accept a licence agreement before you install it.

2 Start the initial scan
Once the installation process is finished, run Clean Master 

and it will immediately scan your computer. This took no time at 
all on our i7-equipped test PC, but owners of slower machines or 
those with particularly full hard drives may have to wait a little 
while as it rifles through your data. Once it’s done, you’ll be 
presented with a screen that shows its findings.

Your guide Ian Evenden says…

T

Ian's best tip
“before you remove data 
from your pC, set a system 
Restore point so you can roll 
back the changes if needed.”

Step-by-step Clean junk from your PC

 Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…
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7 Take a closer look
If you’re not sure what the files Clean Master wants to delete 

are, you can look more closely at them using the ‘Details’ button 
next to ‘Clean’ and ‘Ignore’. This displays the files as a bar chart, 
showing you their size, location and what Clean Master thinks 
they are. Take this further by selecting ‘View’ from next to any bar. 
This opens an Explorer window of the folder the files reside in.

8 Remove installation files
In step 4, we used the Details view to discover that some 

System data was old Windows Defender files. Doing the same 
thing to Skype, under the Social Software heading, reveals that 
the application’s installation files are still on the hard drive. We’d 
like to remove these while leaving the cache, so use View to open 
an explorer window, and delete the install files manually. ■

5 Ignore the web cache
Chrome is the main browser on our test PC, so we aren’t 

surprised to see about 500MB of space used by its cache. This will 
be a mixture of cookies, offline web pages, web app data and files 
stored by the browser to smooth and speed up its browsing. It’s 
useful, and not huge, so we’ll tell Clean Master to ignore it. Click 
the Chrome icon in Clean Master, then select the Ignore option.

3 Get the results
Our test computer is fairly clean, but the results screen has 

still managed to find a couple of gigabytes of data it thinks is 
surplus to requirements. With a 128GB SSD as its boot drive, 
there’s not a lot of space to play with, so it’s worth cleaning even 
that small amount out. Don’t be tempted to hit the big green 
‘Clean Now’ button without looking through the data first.

6 iTunes resource hog
The iTunes application is another matter. It’s a well-known 

resource hog, and even though it doesn’t get much use on this 
PC, it has managed to amass a startling 1.8GB of data. Inspecting 
it shows that most of it seems to be backups from an iPad that’s 
no longer paired with the PC. Cleaning it out is a swift process – 
select the app you want cleaned, then hit the ‘Clean Up’ button.

4 Dig deeper
Scrolling through the results, we come across a section 

marked ‘System cache’. Anything marked ‘system’ should be 
treated with caution, as although it’s unlikely a cleaning 
application would delete something essential to the running of 
your PC, you can’t be sure. Digging through, we find old Windows 
Defender update files, and these can be safely removed.

Explore 
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Learn how to…
Rediscover the 
Control Panel

“Discover how to bypass Settings 
to quickly access key Control Panel 
applets in Windows 10”

espite first appearances, 
Windows 10 hasn’t killed off 
the Control Panel. Although 

you’re strongly pushed towards the 
new – and admittedly improved – 
Settings dialogue first seen in 
Windows 8, the old Control Panel still 
lurks behind the scenes, giving you 
access to just about every system 
setting imaginable. And while a fair 
bit of its functionality has now been 
incorporated into Settings, there are 
still plenty of times when you’ll need 
to access the Control Panel to tweak 
certain parts of your PC.

In some cases, direct links to some 
Control Panel applets can be found  
in Settings itself – look for references 
to ‘advanced settings’ to access them. 
However, in this tutorial we’ll focus on 
revealing key settings that are hidden 
behind the scenes – read on to find 
out more about them, plus gain that 
all-important access.

1 Open Control Panel
The quickest way to open the Control Panel is to right-click 

the Start button and select ‘Control Panel’ from the Quick Access 
menu, or make it even more accessible by typing ‘control’ into the 
Search box, then right-clicking ‘Control Panel’ and choosing ‘Pin  
to Start’ or ‘Pin to Taskbar’. Use the annotation above to help 
navigate it and find the setting you’re looking for.

2 Get system info
The System Control Panel reveals key information about 

your version of Windows and its system type (32-bit or 64-bit).  
It can be accessed by right-clicking the Start button and choosing 
‘System’ or by clicking Start, right-clicking File Explorer and 
choosing Properties. You can also review your current network 
name and workgroup – click ‘Change settings’ to edit these.

Step-by-step How to use Control Panel

Your guide Nick Peers  says…

QuiCk aCCeSS
The quickest way to 
access Control Panel 
in Windows 10 is to 
right-click the Start 
menu and select it 
from the Quick 
Access menu. 

ChooSe CategoRy
The various Control 
Panel applets are 
split into eight broad 
categories – click a 
heading to view all 
available settings. D

  Anyone can do it 
Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

at a glance
Skill level…

Suitable for…
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3 Access System Restore
System Restore is switched off by default in Windows 10 

– access its settings by clicking ‘System Protection’ on the System 
Control Panel or by typing ‘recovery’ into the Search box and 
clicking the ‘Recovery’ entry followed by ‘Configure System 
Restore’. Select your system drive, then click ‘Configure’. Switch  
it on and allocate 5-10% of drive space before clicking OK.

4 Create recovery drive
The Recovery applet also allows you to create a recovery 

drive to help troubleshoot problems when Windows won’t boot 
– leaving ‘Back up system files to the recovery drive’ ticked means 
you’ll need a larger USB drive, but will be able to reinstall 
Windows from the drive. However, it won’t always work. Leave it 
unticked to create a basic drive with troubleshooting tools only.

Jargon buster!
 the Control  

Panel applet
This is a component 
part of the Control 
Panel that handles  
a specific set of 
helpful options,  
such as System or 
User Accounts.

 Quick access
A streamlined menu 
that appears when 
you right-click the 
Start button or press 
[Win] + [X]. It was 
introduced in 
Windows 8.

 RaiD
A technology that 
combines two or 
more physical drives 
into one virtual drive 
for data protection, 
performance 
improvements or,  
if you prefer, both.

SwitCh CategoRy
Once you’ve 
selected a category, 
all other categories 
are displayed in this 
left-hand pane – 
click one to switch. 

available aPPletS
Each applet has  
a number of 
configurable 
settings – click one 
of them to jump to  
a specific option. 

SeaRCh tool
Can’t find what 
you’re looking for? 
Use this search box 
to track it down 
using a keyword  
or two. 

Nick’s best tiP!
You can also use the settings 
search box to find Control 
Panel items - it ’ll include 
them in the search results.

Change view
Click here to display 
all available applets 
as large or small 
icons, or to revert  
to the default 
Category view. 

Explore 
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9 Bring drives together
Storage Spaces lets you combine two or more smaller drives 

into one large virtual drive (or provide protection against data 
loss without having to set up a RAID array). Type ‘storage’ into the 
Search box and click ‘Storage Spaces’. Click ‘Create a new pool and 
storage space’, select the drives you want to join (read the 
warning about deleting data), and let Windows do the rest.

7 Where’s the Action Centre?
The Notification Center appears – on the surface – to have 

superseded the old Action Centre, but in actual fact it’s simply 
been renamed ‘Security and Maintenance’, and the quickest way 
to get to it is via the Quick Access menu (right-click the Start 
button). You’ll find it’s still the go-to place for security and 
maintenance messages, as well as accessing troubleshooters.

5  Restore PC
System Restore can be opened via the Recovery applet too, 

which you can use to roll your misbehaving PC back to an earlier 
point in time. Pick a point, click ‘Scan for affected programs’ to see 
what’ll be affected, then restore your PC. If it fails, try an earlier 
Restore point – click the ‘Show more Restore Points’ to reveal all 
supported points – or undo the change to try a different tack.

10 Default apps
Type ‘default’ into the Search box and click the Default 

Programs shortcut to manage your apps and autoplay settings. 
Click ‘Set Default Programs’ to select an app, review what defaults 
it has and – if necessary – assign it all available defaults to ensure 
it works correctly. Choose ‘Change AutoPlay Settings’ to decide 
what happens when you insert CDs or other media.

8  Get backed up
While Windows 10 supports Windows 7’s Backup feature, it 

favours File History via the Search box and Settings. If you prefer 
the older backup tool, type ‘Windows 7’ into the Search box to 
access it. Once you’ve clicked ‘Set up back-up’ to start it, right-click 
the Taskbar shortcut and choose ‘Pin this program to Taskbar’ to 
give you easy one-click access in future to the tool.

6 Advanced system settings
Access additional system tweaks via the ‘Advanced system 

settings’ button under System, or by typing ‘advanced’ into the 
Search box. Click ‘Settings…’ under Performance if your PC is 
struggling with graphics effects, plus tweak virtual memory 
settings. Click Settings… under ‘Start-up and Recovery’ to stop 
Windows automatically restarting after a blue screen of death.
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15 Set up speech
Type ‘speech’ into the Search box and click ‘Speech 

Recognition’ under Settings – you’ll need to provide a headset  
or mic, then click ‘Start Speech Recognition’, which will step you 
through setting up your computer and training Windows to 
recognise spoken commands. Other options include a training 
programme to help Windows learn how you speak.

13 Edit audio settings
There’s no dedicated Sound section in Settings, but the old 

Control Panel is easily accessible from the Taskbar Notification 
area – right-click the volume icon and choose Playback to manage 
default playback (and recording) devices. Select an entry to make 
it the default, configure speaker settings and tweak advanced 
properties, such as adjusting sound level and quality.

11  Programs and Features
Need to repair or make changes to a program rather than 

simply uninstall it? The Settings app doesn’t cut it. Instead, 
right-click the Start button and choose ‘Programs and Features’  
to access the more powerful Control Panel – you can also manage 
(and remove) Windows Updates from here, plus switch on (and 
off ) Windows features such as the XPS viewer and services.

16 Add permanent shortcuts
Finally, add your favourite Control Panel items to the Quick 

Access menu for quick and easy access. Download Win+X Menu 
Editor (winaero.com/download.php?view.21), extract the program 
files and run the x64 (64-bit) or x86 (32-bit) version depending on 
your Windows system. Choose ‘Add a program > Add a Control 
Panel item’ to add any Control Panel applet to the menu. ■

14  Bypass login screen
Type ‘netplwiz’ into the Search box and click the entry that 

appears to access a hidden User Accounts Control Panel. If you’re 
the only user of your PC, you can configure Windows to bypass 
the lock and login screen by selecting your username, then 
unticking ‘Users must enter a username and password to use this 
computer’. Click Apply, enter password (carefully!) and click OK.

12 Manage credentials
Wonder where Windows stores all those passwords it saves 

automatically? Type ‘cred’ into the Search box and click ‘Credential 
Manager’ to find out. Expand Web Credentials to see which 
passwords have been saved by Edge, Internet Explorer and other 
apps (as well as Windows) – expand one to view or remove it,  
if your user account password as collateral when requested.

Explore 
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Learn how to…
Fix problems 
with photos

“Discover how to improve 
imperfect photos with the help of 
the latest version of Paint.NET”

or years, Paint.NET has 
enjoyed a well-deserved 
reputation as one of the 

best free image-editors for your PC, 
and it’s back with a bang with the 
recently released version 4.0. It’s able 
to take full advantage of your PC’s 
power – its multi-core processor 
and all of its memory – to deliver 
better, more responsive editing tools, 
accompanied by a smattering of 
new features and redesigned user 
interface. If you’re still running  
XP or Vista, you can still download 
the previous version from the  
www.getpaint.net website.

In this tutorial, we’ll run through 
some of the ways in which you can 
use its adjustment tools and filters 
to improve less-than-perfect photos. 
You’ll also discover how to expand 
Paint.NET’s features with the help 
of third-party plugins, so without 
further ado, let’s breathe new life 
into apparently ruined snapshots…

1 First steps
You’ll find the latest version of Paint.NET from  

www.getpaint.net/index.html, so install it from there. If necessary, 
the setup program will download and install the necessary .NET 
Framework 4.5 package. Once installed, launch the program. To 
make changes to an existing image on your hard drive, open the 
File menu and select ‘Open’ to locate and select it.

2 Import photo
Or, choose ‘File > Acquire > From scanner or camera’ to scan 

or transfer a photo. If scanning a photo, click the ‘Preview’ button 
first, then use the drag handles to frame it correctly if necessary. 
Click ‘Adjust the quality of the scanned picture’ for more options 
– we think the default 200dpi setting is a little low, so consider 
pushing it up to 300dpi. Click ‘OK > Scan’.

Step-by-step Correct photos using Paint.NET

Your guide Nick Peers says…

Tool opTionS
Here you can see the available 
options for the currently 
selected tool. Switch tools 
using the palette below. 

Colour paleTTe
Here’s where you 
can set Paint.NET’s 
primary and 
secondary colours. 
Click the ‘More >>’ 
button to access 
additional options. 

F
Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8
 Windows 7

at a glance…
SKill leVel

Time TaKen

SuiTable For

30 minutes
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3 Correct lighting issues
Once scanned or imported, save a copy of your image. If it 

appears too dark or washed out, select ‘Adjustments > Levels’ to 
see a pair of histograms. Click ‘Auto’ for a quick fix, then fine-tune 
the black and white input levels using the sliders on the left to 
select the range of colours to include. Finally, tweak the white, 
grey and black points on the right to get the best result. Click ‘OK’.

4 Fine-tune colour
You can use the Levels Adjustment tool to tweak the colour 

balance too: untick the G and B boxes to adjust the red colour, 
or tick just G to adjust green, or B to adjust blue. You can also tick 
two boxes to adjust yellow (R and G), purple (R and B), and aqua 
(G and B). Once you’ve selected a colour, experiment with its 
input and output levels to see how it affects your image.

Jargon buster!
 Dll

A kind of file that 
adds functionality 
to the program it’s 
associated with, such 
as extra effects in 
Paint.NET.

 Histogram
A tool that is used 
to display the 
distribution and 
density of an image’s 
individual colours as 
well as its overall mix 
of dark, light and 
mid-range tones.

 layer
These are used to 
split different parts 
of an image into 
individual elements, 
each of which can be 
edited separately.

SwiTCH imageS
All open images are displayed 
as thumbnails at the top of the 
program window – click one to 
select it for editing. 

Tool buTTonS
Click these to show or hide the 
main floating tools, change 
Paint.NET’s key settings, and 
access the Help menu. 

HiSTory winDow
This makes it easy to 
review your changes 
step-by-step, and 
undo (or reapply) 
several edits with 
just one click. 

layerS
Manage multi-layered images from 
this window. Click the button in the 
bottom-right of the window to access 
Layer Properties. 

Nick’s best tiP!
Make sure you’re happy with 
your editing before clicking 
‘save’ – once done, you won’t 
be able to undo any changes.

Explore 
Fix problems with photos
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9 Install plugins
Once downloaded, double-click the zip file to open it and 

you should find one or more DLL files. Now open a separate 
folder window and browse to C:\Program Files\paint.net\Effects. 
Copy the DLL files into this directory, ticking ‘Do this for all current 
items’ and clicking ‘Continue’ if prompted for administrator access. 
Once complete, restart Paint.NET to access your new plugins.

7 Apply more fixes
Select ‘Effects > Photo’, where you’ll find five options. 

Both Sharpen and Red Eye Removal are corrective adjustments. 
Sharpen can be used to mitigate the effects of blurring. To remove 
red eye effects, select the elliptical tool and draw a rough circle 
around the first eye. Now hold [Ctrl] and repeat over the second 
eye. Finally, choose ‘Effects > Photo > Red Eye Removal’.

5  Reduce noise
Paint.NET has a number of tools for cleaning up noise, dust 

and scratches. Start by using the Zoom slider (at the bottom right) 
together with the Hand tool to get a closer look at a particularly 
speckled part of the image. Select ‘Effects > Reduce noise’, then 
use the Radius and Strength sliders to reduce the effect of the 
noise without wiping out too much detail. Click ‘OK’ when done.

10 Access plugins
New plugins should appear in the Adjustments or Effects 

menu with a jigsaw icon indicating that they’re third-party 
add-ons. Select one to access its features. Check out this month’s 
Support Squad if your security software blocks any plugins, and 
remove any troublesome or unwanted ones by deleting the DLL 
file from the C:\Program Files\paint.net\Effects directory. ■

8  Get new tools
You can expand Paint.NET’s range of adjustment tools and 

filters with a free third-party plugin. Click the ‘Help’ button and 
choose ‘Plugins’ to visit the Paint.NET forum. Click on a plugin 
to learn more about it, or try a collection such as BoltBait’s 
Plugin Pack for v4.0. When you’ve found one you like, click the 
‘Download’ link to save a zip file to your Downloads folder.

6 Remove larger blemishes
Scratches and larger speckles can be dealt with using the 

Clone Stamp tool. With the tool selected, set the brush width to 
just slightly larger than your first blemish. Now choose a similar – 
but clean – part of the image, hold [Ctrl] and click to select it. 
Place the brush over the blemish and click it once or twice to 
cover it up. Repeat for all the blemishes in your image.
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Learn how to…
Make Edge  
work for you

“Discover how to quickly and easily set up  
Windows 10’s shiny new web browser and  
tweak its settings to suit your needs”

indows 10 sees Microsoft 
debut a brand new web 
browser, Edge. It’s set up as 

your default browser from the off, 
and boasts a slick, minimalist 
interface while promising to speed 
up your browsing. But is it set up the 
way you want it to be out of the box? 
The answer, sadly, is no, but once you 
know where to look, you can quickly 
tailor Edge’s settings to fit in with 
your way of working, not the other 
way round.

First, let’s start by tightening Edge’s 
rather slack privacy settings. Launch 
the browser, then click the ‘…’ button 
in the top right-hand corner and 
choose ‘Settings’. Scroll down and 
click ‘View advanced settings’. Make 
sure the following three switches are 
all set to ‘On’: ‘Block pop-ups’, ‘Send 
Do Not Track requests’ and ‘Block 
only third-party cookies’. Done? 
Good, now let’s take a look at the  
rest of the browser.

1 Import bookmarks
Edge should be able to import from Internet Explorer, 

Chrome and Firefox directly (click the Hub button, select 
‘Favourites’ and click ‘Import Favourites’), but Firefox doesn’t 
always show up. If this happens, export your bookmarks from 
Firefox as a HTML file, then import them into Internet Explorer. 
Import them into Edge using the Internet Explorer option.

2 Change default search engine
When you search in Edge it uses Bing by default, but you 

can switch to another search engine that supports the 
OpenSearch standard. Visit the search engine in question – for 
example, google.co.uk. Then click ‘…’, choose ‘Settings > View 
advanced settings’ and click the Bing menu, go to ‘<Add new>’ 
from the menu. Select your engine and click ‘Add as default’. 

Your guide Nick Peers says…

W

nick’s best tiP
switch to a dark theme – click 
the ‘…’ button , choose ‘settings’ 
and select ‘Dark’ from the 
‘Choose a theme’ menu.

Step-by-step Customise Microsoft Edge

  Anyone can do it 
Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…
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7 Sharing pages
Edge allows you to both annotate and then share web 

pages with others. Click the ‘Web note’ button and use the various 
tools to frame and annotate your page. Once done, click ‘Save’ to 
save the note in OneNote or place it in your Favourites or Reading 
List. Click ‘Share’ to share it using a supported Store app like 
Facebook or Twitter, which you should install separately.

8 Use Internet Explorer
Edge only supports one plugin – Adobe Flash – so some 

websites may not work properly. If this is the case, click ‘…’ and 
choose ‘Open with Internet Explorer’. And if you’d rather make IE 
your default browser click ‘Start > Settings > System > Default 
apps’.  Scroll down to Web browser, click ‘Microsoft Edge’ and 
choose Internet Explorer (or another installed browser) instead. ■

5 Manage your reading list
Edge features a button that allows you to bookmark 

interesting articles for reading later via the star button on the 
main toolbar (select ‘Reading List’, rename it if necessary and click 
Add). Review your reading list via the hub button – choose 
‘Reading List’ to browse the list, then when you’re finished with a 
specific article, right-click it and choose ‘Remove’.

3 Remove Cortana integration
When Cortana is enabled, she’s automatically integrated 

into Edge too, providing suggestions based on your current 
browsing and searches. If you’d like to disconnect Cortana from 
Edge without disabling her completely, click the ‘…’ button in 
Edge and choose ‘Settings > View advanced settings’, then flick 
the ‘Get Cortana to assist me in Microsoft Edge’ switch to ‘Off’.

6 View bookmarks bar and home button
Store frequently accessed bookmarks in the Favourites bar 

folder, then open Settings and flick the ‘Show the favourites bar’ 
switch to On. Restore the Home button by switching ‘Show the 
home button’ on at ‘… > Settings > View advanced settings’. 
Change ‘about:start’ to ‘about:blank’ for a blank page or your 
desired home page’s web address, then click ‘Save’.

4 Customise Reading View
Edge’s distraction-free Reading View displays pages on a 

pale yellow background with a large, readable font. Want to 
change this? Click the ‘…’ button, choose ‘Settings’ and scroll down 
to the Reading section. Click ‘Reading view style’ to choose a 
background colour (light, medium or dark – or white, grey and 
black) and ‘Reading view font size’ to select a different sized font.

Explore 
Beef up Microsoft Edge
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Learn how to…
Get more from 
Windows 10

You can get a lot more from your 
Windows 10 machine with a few 
simple tricks – and here they are!

indows 10 is a powerhouse 
of an operating system. 
Simply put, it’s Microsoft’s 

best yet, with great new features – 
some of which you’re probably 
already using every day. Fortunately, 
there are many other features hidden 
away. If you’re not using these tools 
you’re just scratching the surface of 
what your computer can do. 

For example, did you know that 
you can do away with a lot of the 
keyboard and mouse work you’re 
used to, simply by using the super 
intelligent built-in voice recognition 
assistant called Cortana? This is no 
Paper Clip 2.0 – Cortana can help you 
be seriously productive with very 
little effort on your part. 

There are plenty of other hidden 
secrets too, and some are so simple 
you’ll be kicking yourself you didn’t 
know about them sooner!

1 Use your voice to control your PC
The Taskbar searches for things on the internet or your 

machine. But typing is a nuisance – why not just verbally ask for 
what you want? Activate Cortana voice control by tapping the mic 
button in the search box. You can also start it by saying “Hey 
Cortana”. To do this, click inside the search box, hit ‘Notebook > 
Settings’ and toggle next to ‘Let Cortana respond to Hey Cortana’.

2 Leverage the power of Cortana
Now that you’ve learnt how to activate Cortana easily, you’ll 

want to find out what you can do with it. One of our favourite 
commands is to set a reminder for something. For example, 
launch Cortana and say, “Remind me to buy some milk on [date] 
at [time]” to set a reminder. Find out what else Cortana can help 
with simply by saying “Help” when you ask for Cortana next time.

Step-by-step Get more from a Windows 10 PC

Your guide Nicholas Odantzis  says…

WindoWS Snap
Grab the top of an open 
window and drag it to the 
side of a screen to Snap it 
in place. Do the same on 
the other side. 

SearCh the Web
Start typing into  
the search box and 
you’ll see a list of 
internet results.  
Just click one to 
open it in Edge. 

extra SettinGS
To access some 
handy hidden 
settings, right-click 
the Start button – 
you can even shut 
down your PC here. 

W
  Anyone can do it 
Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

at a glance
Skill level…

Suitable for…
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3 Choose when you want to restart
A major Windows 8 irritation was the sudden restarting  

of your machine after an update – greatly inconvenient if you 
were in the middle of something. Windows 10 allows you to select 
when you want your PC to restart. Type ‘update’ into the search 
box and select ‘Windows Update Settings’. Now choose a restart 
time. To get a restart notification, go to Advanced options.

4 Change the way Windows looks
Windows 10 is one of the best-looking operating systems 

around, but you can make it look just how you like. Right-click the 
desktop and select ‘Personalise’. In the left hand menu you can 
choose from a variety of visual settings. Choose a different 
background, change the accent colour, or a different theme, 
pre-installed or from many available on the Microsoft site.

Jargon buster!
 Cortana

The voice-control 
software built inside 
Windows 10, which 
lets you access 
functions, provided 
you have a 
microphone.

 run
A simple command 
prompt built within 
Windows 10 that 
allows you to quickly 
get to certain 
settings or apps, 
using key words.

 Snap
A feature that lets 
you literally snap a 
window into place 
on one side of the 
screen, and the same 
can be done with 
one on the other 
side, too.

taSk VieW
To get an overview 
of all your open 
windows, hit the 
‘Task View’ button  
to the right of the 
search box. 

pin to taSkbar
The Taskbar lets you 
pin any program  
or folder to it for 
handy access – just 
drag the program 
icon onto it.

aCtion Centre
Click the speech 
icon on the Taskbar 
to open the Action 
Centre and find 
handy notifications 
and settings.

Nick’s best tip!
play solitaire! Yep, it ’s back. 
Just search for solitaire in 
the taskbar and you’ll find 
the solitaire Collection .

Explore 
Get more from Windows 10
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9 Bypass the login screen
The login screen is handy for those wishing to prevent other 

people from accessing Windows, but if you don’t need it, you can 
get rid of it, allowing quicker desktop access. Right-click the Start 
button and select ‘run’ from the menu that appears. Type 
‘netplwiz’ and hit OK. Uncheck the box where it says ‘Users must 
enter a username and password to use this computer’.

7 Record anything
The Game DVR mode allows you to grab videos of your 

screen while playing a game, or capture videos within any 
application on screen. So, if you’re having a problem and you 
want to show a friend what’s going on, you can easily record it. 
Just hold the Windows key and press ‘G’ to bring it up. Then hit  
the red button to start recording. Do the same to stop it.

5  Make the Start menu yours
Beyond making the desktop look great, you can also 

customise the Start menu. Again, go to the Personalisation 
settings menu (as in the previous step) and click ‘Start’ in the 
menu. You can change the way apps appear in the menu, and – 
most importantly – you can make the Start menu full screen when 
you click it by toggling ‘On’ next to ‘Use Start full screen’.

10 Manage your hard drive
Apps, games and large files such as photos can quickly fill 

up your hard drive. Thankfully, you can see what’s taking up the 
most space and manage it. Open the Start menu, click ‘Settings > 
System’ and click ‘Storage’ in the left-hand menu. Click on your 
hard drive for a storage overview, and click on each area to see 
individual programs or files. You can uninstall from there. ■

8  Use Tablet mode
To get a feel for what Windows 10 is like on a tablet, sample 

Tablet mode on your laptop or desktop PC. Click on the ‘Start 
menu > Settings > System’ and select Tablet mode in the left hand 
menu. Toggle the switch under ‘Make Windows more touch-
friendly...’ to turn it on. For super-quick access to Tablet mode, click 
the ‘Action Centre’ icon in the Taskbar and select ‘Tablet mode’.

6 Create multiple desktops
You can create multiple, separate work environments.  

For example, you can have work and play desktops. To create a 
new desktop, hit the ‘Task View’ button in the Taskbar and click 
the ‘New desktop’ button. When you open a window in an 
individual desktop, it will only appear there. Hit the ‘Task View’ 
button again to explore each desktop.
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Learn how to…
Write your  
first novel

“Plan your perfect story and then 
write it with the help of the free 
yWriter word processor”

hen there’s a story in your 
head that you’re itching to 
commit to paper, you need 

yWriter. This is more than just a 
simple word processor; it’s a fully 
featured project management tool 
aimed at budding novelists. It 
provides everything you need to 
plot, structure and write your tale, 
including tools for managing your 
story’s characters, locations and 
objects, plus a handy set of note-
taking features.

yWriter divides your story 
into chapters, which are split into 
scenes. This lets you break each 
chapter down into manageable 
chunks that can then be rearranged 
at any time. You’re then provided 
with everything you need to write 
your story, complete with easy access 
to all that planning material to keep 
things consistent. All that’s left is for 
you to unleash your inner author. 
Read on to find out how…

1 Set up your project
Install yWriter from www.spacejock.com/yWriter5 then 

launch the program. Open the Project menu and choose ‘New 
Project Wizard’. Click ‘Next’, then enter your project’s title. Click 
‘Next’ and type your own name, then click ‘Next’ again. Now click 
the ‘…’ button to pick a suitable folder to save your project to. 
Once done, click ‘Next’ followed by ‘Yes’ to create the folder. 

2 Create first chapter
Open the Chapter menu and choose ‘Create new chapter’. 

Change the title from Chapter 1 if required, then provide a brief 
description of what happens in the chapter. Ignore the Scene 
Summaries tab – this is read-only and filled automatically when 
you set up each scene. If your book is going to be split into 
sections, tick ‘This chapter begins a new section’ and click ‘OK’.

Step-by-step Plan, write and publish your novel

Your guide Nick Peers says…

ChapterS
yWriter organises your 
story into chapters. Click 
one to select it, or double-
click it to rename it. 

projeCt NoteS
Use this tab to 
record notes that 
apply to your whole 
story. You can also 
alter existing notes 
from here via the 
‘Edit’ button. 

W
Anyone can do it 
Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

at a glance
Skill level…

Suitable for…
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3 Set the first scene
Each chapter is broken down into individual scenes, which 

split your story into manageable bite-sized pieces that can easily 
be moved around. Open the Scene menu and choose ‘Create New 
Scene’ to open the main Scene editing window. First, choose a 
suitably descriptive title to help you identify the scene, then add a 
more detailed description beneath it – typically a brief synopsis.

4 Add characters
You’ll see a Viewpoint menu above the scene title – this 

allows you to choose the scene’s main protagonist. First, you need 
to create one or more characters. Click the ‘Add’ button to the 
right followed by ‘Add new’ when the new window appears. Start 
by giving the character a short name and indicating whether 
they’re minor or major, then fill in the rest of the Name tab.

Jargon buster!
 autobackup

yWriter makes 
backups of your 
main project files 
once a day, but also 
backs up a scene 
each time it’s 
opened for editing. 
Access these via 
‘Tools > Backups’.

 Scene
The basic building 
blocks of your story, 
scenes are short 
passages of text 
that combine into 
chapters to form 
your story’s narrative.

 Storyboard
A graphical 
horizontal timeline 
view of your novel, 
organised by 
chapter, showing 
each character and 
the scenes in which 
they appear.

toolS meNu
You’ll find some handy 
project management 
tools here, including a 
storyboard function 
and access to previous 
story autobackups. 

SCeNeS
Each chapter is 
broken down into 
scenes. The selected 
chapter’s scenes are 
shown here. Double-
click one to edit it. 

SCeNe Summary
The selected scene’s 
content will be shown in 
this pane – the Content 
tab is read-only. To edit 
it, double-click the 
scene above. 

editable tabS
All other scene tabs 
– including Description, 
Characters, and Scene 
Notes – can all be 
edited from the main 
yWriter screen. 

Nick’s best tiP!
Check the Reports menu, 
where you’ll find some useful 
tools to help you plan your 
time and view your progress.

Explore 
Write docs with yWriter
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9 Rearrange your story
One of yWriter’s strengths is the way it allows you to reorder 

your story – simply drag and drop scenes to move them around, 
or drag a scene to another chapter to move it to that chapter. 
Want to split a lengthy scene in two? Easy: simply type a # at the 
point you wish to break the scene in the Scene Editing window, 
then choose ‘Scene > Split scene on ‘#’’ to break it up.

7 Advanced scene tools
Check out the other tabs: Details records information such 

as how long the scene is, or whether it’s a major plot or subplot. 
The Locations and Items tabs allow you to attach key places 
and objects to the scene (right-click under ‘Present in Scene’ 
and choose ‘New’) to help you keep track of what’s linked where. 
There are also tabs for scene-specific notes, photos and goals.

5  Complete character setup
If applicable, use the Bio tab to provide your character 

with a background. The Notes tab lets you record miscellaneous 
information about them, while the Goals tab lets you specify 
their motivation. The Picture tab lets you attach an image to the 
character – not really required unless you’ve based them on a real 
person and want a visual cue to help you describe them.

10 Keep writing – and publish!
Now you have all the tools in place to help you, there’s no 

excuse not to embark on the novel, memoir or travelogue that’s 
been rattling around in the back of your head. yWriter supports 
multiple projects too, so you can work on more than one story at 
once. Once it’s complete, choose ‘Project > Export Project’ to save 
it in your preferred format, including text, ebook and HTML. ■

8  Review and update
Click ‘Save and Exit’ to return to the main screen where 

you’ll see a summary of the work you’ve done so far. Select a 
chapter from the left-hand column and all its scenes will appear in 
the right-hand pane. You’ll notice your scenes have a status. This is 
set to Outline by default, but you can change this by right-clicking 
the scene and choosing ‘Draft’, ‘Edit 1’, ‘Edit 2’ or ‘Done’.

6 Start writing
You can now start typing the scene into the Content tab’s 

text window. You’re supplied with some basic formatting tools, 
including a useful highlighter. Click the ‘Save’ button regularly 
to update your work. When you’re ready to move on to the next 
scene in your story, simply select ‘Scene > Add Scene (after 
current)’. You don’t need to finish your current scene first.
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indows 10 is pretty 
bulletproof. However if you 
are unfortunate enough  
that something should  
go wrong with it, what can 
you do to get your machine 

back up and running quickly and easily?
Thankfully the latest version of Windows 

comes with everything you need to take charge 
of the situation and fix problems, using a 
combination of different tools. 

In this feature, we’ll show you how to make 
sure your important data is backed up first. Then 
we’ll investigate the various utilities that can 
bring your device back to life – from a simple 
rollback of key system files and settings, to a 
full-blown reinstall of Windows itself. It could be 
that a simple restore will do the trick instead of  
a more radical reinstalling of Windows.

 Windows
Has your PC started behaving strangely or 
sluggishly? Read on to discover your options 
for restoring Windows 10 to its best

Restore,     refresh  reinstall
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By default, the built-in File History 
tool automatically backs up all the 
content from your libraries, contacts, 
favourites, OneDrive folder and 
desktop. If you want to back up any 
folders, as well, you can do so by 
adding them to a library, and you can 
then choose ‘Exclude folders’ from  
File History’s ‘More options’ screen  
if you want to remove specific folders 
from the backup.

Earlier versions 
Once you’ve got everything set up,  
click ‘Turn on’ (if it’s not automatically 
done for you) and File History not only 
starts backing up your files, but backs 
up different versions of them, too, 
giving you the option to roll back 
through your files to earlier revisions, 
which can be really useful. 

There are two ways to recover your 
files. Firstly, if you want to restore lost 
or accidentally deleted files, click 
‘Restore files from a current backup’  
in the ‘More options’ section of File 
History. From here, you can browse 
your backups by location or library,  
or search for specific content. 

It’s just as simple to restore an earlier 
version of a file. Browse for it in an 
Explorer window, select the file in 
question and click the ‘History’ button 
on the Home tab of the ribbon to see  
a list of previous versions of the file, 
before restoring the one you want. 

When it comes to backing up other 
key settings and files, the guide 
opposite has all the tips, tools and tricks 
to keep all aspects of your PC safe.

 T
aking the steps required to 
protect your saved files is 
crucial. Think about the 
priceless photos, home 
movies, music library, 
important work documents 

and other irreplaceable files and 
settings that would be lost in the event 
of a disaster. The good news is that 
backing up your files couldn’t be easier, 
and the tools you need are provided  
in Windows 10 itself.

When it comes to backing up your 
files, the File History tool is your first 
port of call. To access it, click Start > 
Settings > Update & security > Backup, 
then follow the step-by-step guide  
on page 66 to set it up to work with 
your backup drive, whether that’s an 
external USB drive, a network share or 
network attached drive. Back up your 

files online
Add an extra layer to your 
emergency recovery plan
As anyone who’s experienced a 
hardware failure will know, you can 
never have too many backups. So 
even after using File History to back 
up your files, you should explore 
another option, just in case. 

We recommend using an online 
backup, because it means there’s  
a copy of your files stored in a 
separate physical location for your 
extra protection.

The obvious choice for Windows  
10 users is to use the free OneDrive 
desktop app, which enables you 
to sync up to 35GB of files to the 
cloud for absolutely nothing. You’ll 
find it  on your Start screen – just 
click (or tap) on the OneDrive title  
to launch it.

If you need more storage space, 
you can purchase additional 
gigabytes in the ‘Manage storage > 
Upgrade’ area of OneDrive online. 
The 100GB plan is £1.99 per month, 
or you can get 200GB for £3.99 a 
month. Pay £5.99 a month, however, 
and you’ll get Office 365 plus a 
whopping 1TB of storage too.

File History enables 
you to back up key 
files automatically

Keep your work safe with the File History feature

Take a backup

“Backing up your files couldn’t be 
easier and the tools you need are 
provided in Windows 10 itself”

62  |    |  Christmas 2015



Create rescue media
Taking a few minutes to make a recovery  
USB drive could save you hassle in the future
A recovery USB flash drive lets you access essential repair 
and recovery options that can save the day if your PC  
or tablet fails to boot. If your Windows 8.1 device has a 
recovery partition, you can store that on the drive, too.  
A basic recovery drive without a recovery partition 
requires a 256MB USB flash drive, but you’ll need a drive  
at least 4GB in size if you plan to make a backup of the 
recovery partition, too (which is recommended).

To create the drive, plug in your USB flash drive, then 
type the word recovery into the search box. Select the 
‘Create a recovery drive’ option under ‘Settings’, then 
follow the prompts to create your recovery stick. After  
the process has finished, select the option to delete the 
recovery partition only if you’re low on storage space.

Back up your 
settings
Use Windows 10’s Sync Your Settings tool for 
extra protection if disaster strikes

If you log on to your Windows 10 PC using your Microsoft 
account, you can take advantage of Windows’ built-in Sync 
Your Settings feature. Although this tool is designed to 
synchronise personal settings across your Windows 
devices, it also serves as a backup for key preferences so 
you don’t have to set them up again should disaster strike. 
Make sure ‘Sync Your Settings’ is on and choose the 
settings you wish to back up – to do this open Settings 
from the Start menu, select ‘Accounts’ followed by ‘Sync 
your settings’. You’ll find switches to turn the feature on 
and off, and you can also exclude settings from the 
backup, such as passwords or browser settings.

Take a drive image
Make a complete backup of your computer’s 
hard drive with Macrium Reflect Free
Having a backup of your entire system enables you to 
quickly restore your PC to exactly how it once was. 
Windows 10 has a built-in drive image tool, but you can 
get better, more efficient results with Macrium Reflect 
Free. Download it at www.macrium.com/reflectfree.aspx.

There are two basic back-up options, but we’re going to 
choose ‘Create an image of the partition(s) required to 
backup and restore Windows’. Make sure the correct 
drives have been selected, then click the ‘...’ button next 
to ‘Folder’ to select a location on your back-up drive. 
Finally, click ‘Finish > OK’ and the backup will be created. 
Once complete, check that the backup is not corrupt by 
switching to the Restore tab and clicking ‘Verify image’ 
next to it. Finally, select ‘Other tasks > Create rescue 
media’ to create a Macrium recovery disc or USB drive.

Windows
Restore, refresh, reinstall
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you can perform a more radical  
step: go back to the previous build  
of Windows 10.

When you perform a major update 
of Windows, or Windows 10 installs a 
major new version, it creates a backup 
of the previous build, just in case you 
run into any problems. This backup is 
stored in the ‘Windows.old’ folder – it 
can take up a fair bit of space, and can 
be removed using Disk Cleanup. But if 
you have the spare capacity, leave it in 
place in case you ever need to use it 
to fix a problem.

You’ll then be asked to give a reason 
for why you’re rolling back Windows 
– this helps highlight issues that may 
require an urgent fix.

You’ll then be given a brief summary 
of the changes being made (no 
specific details are available, unlike 
with System Restore, sadly), with a 
prompt to back up for safety’s sake  
(if File History is turned on, you’re 
probably covered). Click Next, make  
a note of the warning about your 
logon password and then click Next 
again, sit back and wait while your  
PC is restored.

If all goes well, you should have a 
working version of Windows 10 again, 
with just a few maintenance tasks  
to perform (reinstalling programs, 
updating settings, and so on) before 
everything’s back to normal.

Beyond a rollback
Unfortunately, rolling back your PC  
to the previous version of Windows 10 
won’t always cure all issues. You may 
find your device still doesn’t function 
as it should after you’ve refreshed it, 
or the procedure might not work. If 
Windows comes across a problem, it’ll 
inform you of the fact, try to resolve  
it and then, if the fix fails, undo all the 
changes it’s made, leaving you back 
where you started.

If all else fails, fixing your PC will 
involve something more drastic:  
a complete wipe and reinstall of 
Windows itself in what is now termed 
a ‘reset’ of your PC. The good news  
is that you can perform this action 
without losing your data or by wiping 
the drive entirely. However the end 
result is the same: you’ll lose all your 
settings and apps.

Y
our PC has run into 
problems and you  
have exhausted all the 
obvious troubleshooting 
angles. So what can you  
do to try to get things 

working properly again? 
The next step in Windows 10, like 

earlier versions of Windows, is to 
investigate the System Restore tool. 
System Restore works in a similar way 
to File History, only it affects system 
and program files instead of your 
personal data. Snapshots of these files, 

Restore or roll 
back your PC
If the problem with your device is only relatively minor,  
then you can often fix it without affecting your data

“If System Restore doesn’t fix the 
problem you can perform a more 
radical step: roll back your PC”

known as Restore Points, are taken at 
key moments during general use, and 
if you run into problems, you can try 
rolling back to a previous Restore 
Point to see if it fixes the problem.

System Restore
System Restore usually works best 
when your problem has been caused 
by a recent change to your computer, 
typically through installing or 
updating new hardware, software  
or Windows itself. The step-by-step 
guide opposite reveals how to access 
and use System Restore, either from 
within Windows or via your 
computer’s recovery menu.

If System Restore doesn’t do 
enough to fix the problem, then  

Rolling back your system in this 
way works in a similar fashion to 
System Restore: your data is 
unaffected, but any changes made 
since the new build was installed,  
like changes to settings or programs, 
newly installed apps and so on, will 
be undone.

If you need to use the rollback 
feature, and Windows is working well 
enough for you to access it normally, 
open Settings before selecting 
‘Update & security’ followed by ‘Go 
back to an earlier build’. If Windows 
won’t boot, use your recovery drive 
or select ‘Troubleshoot > Advanced 
options’ to access the option.

You’ll see a message telling you 
Windows is getting things ready. 
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Send your PC  
back in time
Choose a Restore Point to 
undo problematic changes

To restore a recommended Restore 
Point, click ‘Next’ and follow the 
prompts to roll back your PC. If this 
doesn’t work, or you want to try  
an earlier Restore Point, select 
‘Choose a different Restore Point’ 
and click ‘Next’. Browse through 
the available points, noting what 
would be affected by choosing 
each one. After restoring, you can 
undo the process if it doesn’t have 
the desired effect.

System 
Restore
For when things go wrong
If you can boot into Windows, 
access System Restore via the 
desktop. Type ‘System Protection’ 
into the search bar and click  
‘Create a restore point’ followed  
by ‘System Restore...’ If Windows 
won’t start, you can use System 
Restore automatically. Or, boot 
from your USB recovery disk, select 
‘Troubleshoot’, ‘Advanced options’ 
and then ‘System Restore’.

Restore 
Points
Decide how far Windows 
should turn back the clock
By default, Windows recommends 
you use the most recent Restore 
Point; in fact, you may even find 
it’s the only Restore Point offered. 
Make a note of the time and date 
it was taken, and click ‘Scan for 
affected programs’ to see which 
programs and hardware drivers 
will be affected by rolling back 
your PC to this point. You’ll see the 
programs that will be removed if 
you choose it, and others that will 
be restored. This should help you 
decide whether to use it or not.
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T here’s no need to tear  
your hair out if nothing 
seems to help with the 
troubleshooting. You can 
go the whole hog, wipe 
your hard drive clean  

and restore Windows to its factory 
settings. This approach will delete any 
personal data you have saved on the 
drive, so make sure it’s fully backed  
up first, using our guidelines earlier. 

It’s also a good idea to make a note 
of any programs you’ve installed on 
your PC, so you can download and 
restore them after Windows has 
been reinstalled.

Reinstall Windows
Microsoft knows how painful the 
reinstall process can be, which is why 
with Windows 10 it’s gone out of  
its way to make the process easier 
than ever for you. 

The simplest way to reinstall 
Windows is through Windows  
itself. Click ‘Start > Settings >  

Update & security > Recovery’  
and then choose ‘Get started’ under 
‘Reset this PC’. A full reinstall wipes 
your entire drive, so select ‘Remove 
everything’ to ensure a clean reinstall 
is performed. If Windows fails to  
load, you should be shown the 
troubleshooting screen, which you  
can also access via your recovery  
drive if you created one. In these 
circumstances, select ‘Troubleshoot’ 
followed by ‘Reset your PC’. 

One of the benefits of this new 
approach is that Windows attempts  
to recover from a previously created  
system image or – failing that – using  
a special series of install files that 
download the latest version of 
Windows during the reinstall process. 

In practical terms this means you’ll 
avoid a lengthy series of post-install 
updates to download and install in 
order to bring Windows itself back  
up to date. The reset process is simple: 
your PC reboots, then after a pause 
while things are being prepared,  

1 Restore settings
You’ll need to log into your Microsoft account  

in order to restore your synced settings and previously 
installed apps. Before these are all restored, you’ll need 
to verify your account on this device: click ‘Start > 
Settings > Accounts > Your account’ and click the 
‘Verify’ link to get the code required to add your PC 
back into the trusted list.

2 Restore apps
Open the Windows Store (‘Start > All Apps > 

Store’), click your user photo and choose ‘My Library’ 
to access all previously installed apps (and your 
settings). Click ‘Show all’ and then click the download 
button next to each app you wish to restore. Once 
done, click your user photo again, but this time choose 
‘Downloads’ to update the built-in apps.

 UsE yoUR BaCkUPs

Reinstall  
   or recover?
If all else fails, a 
full recovery or 
reinstall should  
fix your problem 
– but make sure 
you’ve backed  
up first!
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3 Restore files
Finally, restore your files using File History. With 

your back-up device plugged in, click ‘Start > Settings > 
Update & security > Backup’ . Click ‘Add a drive’ to select 
your back-up device, then click ‘More Options’ followed  
by ‘Restore files from a current backup’. Click the Settings 
cog and choose ‘Restore’ to recover your data. This can 
take a little time, so be patient. ■

you may be confronted by a screen 
asking you if you want to remove 
files from all of your drives, or just 
the drive that Windows is installed 
on. Unless you’re planning on 
disposing of the PC, select ‘Only the 
drive where Windows is installed’ to 
protect data files stored on other 
partitions or drives.

You’ll also be given an option 
 to ‘clean the drive fully’ – again,  
skip this unless you’re selling  
on your PC. Finally, click ‘Reset’  
and let your PC do the rest.

Post reinstall
Once restored you’ll have a brand 
new system at your disposal and it’s 
time to reinstall your apps, apply 
preferences and restore backed-up 
data. The step-by-step walkthrough 
shown below reveals everything  
you need to know. 

Of course, you’ll need to reinstall 
your key desktop applications, too, 
after this has been done. Again, take 
the time to download the latest 
versions and set each one up. This 
can all take an hour or two – to 
speed up future reinstalls, check out 
the box below-right to create the 
perfect Windows image, complete 
with all your apps, programs and 
settings in place. ■

Belarc Advisor
Lost or forgotten your 
Windows or software 
product keys? Get  
them back before 
reinstalling with this.
www.belarc.com

Speed up future 
Windows reinstalls
Get your perfect Windows setup quickly  
and easily next time you have to reinstall

Reinstalling and setting up Windows again can be a 
chore, so speed up future reinstalls by creating a perfect 
recovery image. After reinstalling Windows and apps, 
reinstall your key programs and set them up as you like 
them. Then, before you restore your File History backup, 
launch Macrium Reflect Free and take a new drive image. 
Create a recovery CD or USB stick following the prompts, 
and next time you need to reinstall Windows, make sure 
your File History backup is up to date, then boot from 
your recovery media before restoring this drive image. 
All you’ll need to do is bring Windows and your apps up 
to date, and reinstall new programs. Before restoring 
your File History backup, create a new drive image to  
use the next time you need to reinstall Windows.

5 Handy 
RECovERy  
Tools
Fabulous freebies to help  
you get going again  
in Windows 8.1

Comodo Backup
This Comodo Backup  
tool gives you granular 
control over what  
you back up and can  
be fairly useful. 
www.comodo.com

Partition Wizard 
Home Edition
Partitioning your hard 
drive lets you separate 
your data from your 
programs. www.
partitionwizard.com

Ninite
This tool lets you select 
lots of popular apps,  
then download and  
install them all in a  
single package.
www.ninite.com

DriverEasy
This handy tool can  
find and install any 
hardware drivers you 
can’t identify after 
reinstalling Windows.  
www.drivereasy.com
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W

The 20 best  
FREE gamEs
Right now for your PC

e’re under no illusion that playing 
games can be one of the biggest 
time-sucks out there. And with so 
many to choose from, there really 
are not enough hours in the day. To 

soften the blow of gaming addiction we’ve 
compiled a list our favourite games that are 
completely free to play (F2P). However, if you’re 
feeling generous you might want to thank the 
heroic developers by leaving them a little 
donation on their site.

The games over the next few pages are as good 
as any paid game. There should be something  
for everyone. It’s worth saying we’ve had to  
leave out an awful lot of great games. Most sadly 
was the amount of indie games we’ve not been 
able to cover. Look on sites such as Warpdoor 
(www.warpdoor.com) and IndieGames (www.
indiegames.com) to discover these smaller titles.

And to mention just a few others… League of 
Legends, World of Guns, Flow, Humanoid 47, 
Kingdom of Loathing, A Dark Room, Fallen 
London, No One Has to Die, Neverwinter, Smite, 
Hawken, Wolfenstein 3D, Tyrian, Realm of the 
Mad God…

Westerado
The West was full of hard men with identikit 
faces who you can try to recognise from 
wanted posters. Men whose hats you can 
shoot off. Men who can pull a gun at any 
point during a conversation, just to make a 
point. Westerado is half Zelda-world-
exploration game and half slapstick-gritty 
tale of cowboy revenge, and it’s incredibly 
stylish and totally free. If you want to 
support the developers, a paid-for version 
of the game with slightly more content is 
available on Steam. http://bit.ly/1dVw25e

Card Hunter
One of the smartest games around, Card 
Hunter is a mix of D&D and Magic: The 
Gathering. You take the role of a team of 
geeks playing an RPG against their novice 
dungeon master. You have three characters, 
each with a deck of cards determined by 
their class, race and equipment. With a neat 
plot following the fictional roleplay session, 
as well as a separate story in-game, there’s 
also a PvP mode. The recent expansion 
added science-fiction tropes.  
www.cardhunter.com

samorost 1 & 2 
Amanita’s delightful browser games (named 
after the Czech for ‘driftwood’) are set on a 
strange, small planet inhabited by a gnome. 
You control him to avert a collision with a 
spaceship by solving a series of surreal 
organic puzzles. Creative character designs, 
innovative art and a haunting soundtrack 
made both games a success. Later, the same 
company made Machinarium, generally 
considered to be the best indie game of 
2009. Now it’s working on Samorost 3. 
http://amanita-design.net/games.html

Words: Daniel Griliopoulos
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TRackmania naTions FoREvER 
Few game developers know how to bottle joy. It takes a combination of special things – 
bright, clear art, simple mechanics and endless replayability. Super Mario Sunshine has it, 
and so does the PC-only stunt-racer Trackmania. It also lets you create your own tracks, 
try them out, share them and challenge your friends. Forever isn’t the newest version of 
Trackmania, but it combines the best earlier versions of the game – Trackmania Original, 
Sunrise and Nations – which means it has huge amounts of content. Visit:  
http://trackmaniaforever.com

LoRd oF ThE Rings onLinE
Rift may be much shinier, and Dungeons & Dragons: Online might be more familiar to 
most gamers, but the now-aged LOTRO will always have a special place in our hearts. 
Players take control of an innocent, whose plot tracks alongside the plot of the Lord of the 
Rings books, supporting the Fellowship quietly. With beautiful recreations of the Shire, 
Rivendell, Moria and Weathertop, it genuinely feels like Middle Earth. On the flip side, you 
can also play as a max-level monster in PvP against other humans. We just hope they can 
keep the game going to complete the story. www.lotro.com

The Death  
of MMOs
The free games revolution opened 
up all sorts of genres that seemed 
stagnant or vanished – puzzle 
adventure games have been revived 
by the hidden object game, and 
platformers by the flash platform – 
but it’s slowly spelled the death 
knell for paid-for massively 
multiplayer online games, or MMOs.

“Free-to-play, it’s the better 
business model,” Mike Donatelli told 
us. He’s from Carbine Studios, 
creator of Wildstar. “There are no 
barriers to entry. Pick any forum and 
there’ll be people saying, ‘I like the 
game, I’m just not paying you any 
money for it.’ We acknowledge the 
MMO community has evolved past 
the (subscription) business model.”

It’s also interesting that investing 
huge sums of money into creating 
these MMOs seems less attractive, 
as revealed by Blizzard’s Mike 
Morhaime, when the dev’s World of 
Warcraft follow-up Titan was 
cancelled. “We didn’t find the fun,” 
he said. “We didn’t find the passion. 
We talked about how we put it 
through a reevaluation period, and 
actually, what we reevaluated is 
whether that’s the game we really 
wanted to be making. The answer is 
no.” The games that it seems to want 
to be making are Hearthstone and 
Heroes of the Storm – both free, 
small, multiplayer, skill-based games 
with strictly limited ambition. So 
Titan was turned into a small, 
skill-based multiplayer shooter 
called Overwatch.

Of those MMOs that were 
subscription-based very few are  
still so. Star Wars: The Old Republic, 
Rift, Dungeons & Dragons Online, 
Neverwinter, Star Trek Online, The 
Elder Scrolls Online… they’ve all 
changed their stripes, cancelling  
the subscription charges and  
quite often the upfront purchase 
cost as well, instead charging for 
in-game fripperies.

Free-to-play MMOs, 
such as Nevermind, are 

now the norm

Get your Lord of the 
Rings fix for free 
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Team Fortress 2 
was the game that 
kickstarted the  
F2P revolution

dota 2
There’s no denying the popularity of Valve’s 
team arena game. At the time of writing, 16 
teams are competing for a prize of millions, 
with much of the money coming from the 
game’s community. The game has you 
taking control of a unique character 
alongside four others, playing against 
another team of five in a RTS map. You 
need to level up and take down the 
enemy’s towers and fortress, while 
preventing them from destroying yours.  
http://blog.dota2.com 

HeartHstone 
Another Blizzard title, this game signifies a 
huge change in the World of Warcraft dev’s 
style. Instead of creating huge games that 
cost the GDP of a small country to rake in 
tons of money… it’s doing the same thing, 
but with free games. Hearthstone is a 
Collectible Card Game, in which you pay or 
play to unlock cards, building decks for 
competitive play, or for use against the AI in 
one-off battles or story campaigns. It’s 
highly skillful, but also rewards casual 
players. http://bit.ly/1F2zqJn

Lessons from  
Mobile Gaming
Free gaming may have started on PC 
with freeware titles like Wolfenstein 
3D, but mobile games are its home. 
Take a squint at that image above – 
that’s the top 50 highest grossing 
games on iOS on a particular day in 
August this year. The highest ranked 
paid-for game was Minecraft: 
Pocket Edition ($6.99) at 
number 24, followed by the 
creepy Five Nights at Freddy’s 
at 39. Apart from that, every 
other game was free and making 
huge amounts of money. Clash of 
Clans, already out for years, made 
$1.6 million in a week, in just the US.

This is partly a result of the ease of 
microtransactions on mobile 
devices. Players can buy an in-game 
item for a miniscule sum of money 
without leaving the app or hunting 
down their credit card information 
– indeed, on the newer iPhones, it’s 
just a tap of your thumbprint and 
you’ve spent the money. 

It’s partly because the developers 
making games on these platforms 
are obsessed with money. These 
aren’t hipster indies keen to 
demonstrate their credentials and 
make a critical success. If you attend 
one of the mobile game 
conferences, such as Pocketgamer 
Presents or Mobile World Congress, 
the talk is all about monetisation, 
and has been for years. How to 
make money more efficiently? How 
to buy customers and good reviews? 
How to game the various in-game 
advertising systems? How to 
artificially bump yourself up the 
charts and get Apple’s attention? 
Every year, Apple bans another 
method of making money from 
mobile games, like some financial 
regulator dealing with dodgy banks.

But it’s mostly the result of market 
saturation. There are so many 
games released every day – so many 
good ones and so many knock-offs 
– that the effect has been to push 
the price to zero. Why buy Angry 
Birds for £1.99 when you can get the 
functionally identical Ornery Avians 
for free? It’s a constant worry of PC 
game developers that the price of all 
games will be driven down to zero. 
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Path of Exile may not 
be as pretty as the 
paid-for titles, but it 
packs as much punch

PaTh oF ExiLE
Though Diablo 2 is widely acknowledged as the king of the action RPG genre, and  
Diablo 3 is the prettiest example of the genre (save for maybe Torchlight 2), these are 
paid-for games. By contrast, Path of Exile is neither particularly beautiful, not as crunchy  
as Diablo 2, but it is free and extremely well-made and compelling. It’s the kind of game 
where you kill thousands of enemies in your lust for loot – and maybe to move the story 
on. It has a range of game modes (called ‘leagues’) that change regularly. Oh, and it has 
the world’s most ridiculous skill tree. www.pathofexile.com

TEam FoRTREss 2
Though Team Fortress 2 has fallen 
out of favour in recent years, it was 
the game that revolutionised 
free-to-play gaming. Players 
compete in two teams of cartoon 
movie caricatures – from the 
minigun-toting Heavy to the 
Germanic-accented Medic – battling 
over objectives such as capturing 
bases or simply killing as many of 
each other as possible. A range of 
game-mode additions, AI bots, 
custom maps and a huge range of 
weapons – both randomly dropped 
and bought – have given the game a 
huge amount of replayability.  
www.teamfortress.com

Heroes of tHe storm 
It seems mad to have two multiplayer 
online battle arenas (MOBAs) here. 
Particularly two that are so similar. And 
especially mad to leave out League of 
Legends. But LoL is older than Dota, and 
features almost identical gameplay to an 
outsider. By comparison, Heroes of the 
Storm is more casual and accessible. Players 
take control of a hero from the Starcraft, 
Warcraft and Diablo universes, with a larger 
variety of maps compared to DOTA and 
LoL. http://eu.battle.net/heroes/en/ 

frog fraCtions
The game is a strange amalgam of parody 
and adventure, sometimes feeling like an 
edutainment game, sometimes like an 
escapee from Monty Python. It only lasts an 
hour, but takes you through politics, 
philosophy, drama, a law court, a strange 
upgrade tree and much time spent eating 
insects. The sequel has been Kickstarted but 
not released – indeed, the creator has 
suggested he could release it under a 
completely different name.
http://twinbeard.com/frog-fractions/ 

tHe Cat and tHe Coup
There are many free indie games,  
but few with a message as moral  
as The Cat and the Coup. Players  
control the president of Iran’s cat  
during the CIA/MI6-engineered coup  
that brought down the democratically 
elected government, and led eventually 
to the current Islamic state. You use the 
cat to solve puzzles and move the 
president. It’s as much interactive art  
and history lesson as it is a game.  
www.thecatandthecoup.com
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n 2.0 
The N games have quietly been the 
inspiration behind many other action-puzzle 
games, but have never achieved mainstream 
success. You control a ninja, who uses 
impetus and physics to make his way 
through a maze of death. Homing missiles, 
mines and plain-nasty gravity are all threats 
as you collect keys and points, and attempt 
to complete each level in double-quick 
time. If you like this, you can buy the 
comprehensive N++, which has just come 
out. http://bit.ly/1mQIEnc

tHe ur-Quan masters 
In 1992 there was a game called Star 
Control II that involved the exploration of 
star systems, hyperspace travel, alien 
diplomacy and 25 alien species to ‘engage’ 
with. But really, beneath the skin, it was an 
adventure game, where you pilot the last 
surviving free spaceship in a bid to free the 
galaxy from the despotic Ur-Quan, while 
they’re distracted by civil war. The Ur-Quan 
Masters is an open-source 2002 port that 
brought Star Control II to modern operating 
systems – for which, we’re very grateful. 

tHe republia times
Lucas Pope is better known for creating 
Papers Please, the dystopian border control 
game, where you have to balance your 
family’s welfare, a totalitarian state’s insane 
laws and the lives of those crossing the 
border. This game is another of his. As the 
editor of a propaganda newspaper, in The 
Republia Times, your job is to keep as many 
of the people loyal as possible, despite the 
dreadful things your regime is doing, by 
emphasising only positive stories. Visit:  
http://bit.ly/1JuTKYS

WoRLd oF Tanks
Developer Wargaming.net now employs several 
thousand people across 16 countries, as well as owning 
much of Cyprus, and it’s all down to the surprising 
success of World of Tanks (and its sister titles World of 
Warplanes and the forthcoming World of Warships). 
WoT is the one that’s paid for all those staff though, 
and that’s because it’s like a very slow FPS. Players take 
control of a range of historical tanks in PvP battles – 
from heavy monsters like the Tiger II, to tank hunters 
and artillery – and attempt to either destroy the other 
team or capture bases. http://worldoftanks.com

nEPTunE’s PRidE 2 
How much do you like your friends? Really 
like them? How much would it take to break 
you apart? If the answer is ‘not a lot’, then 
you might want to move on from Neptune’s 
Pride. The game, like the boardgame 
Diplomacy, is a real-time game of power 
balances and betrayal set within a galactic 
space. You gradually build your fleets and 
your friendships with your neighbours, 
conducting diplomacy, researching 
technology, forming alliances, reinforcing 
your planets and investing in peace… and 
then you turn on each other in an orgy of 
destruction. As each game can take several 
weeks, the betrayals really hurt.  
http://np.ironhelmet.com 
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anCHorHead
There are thousands of text adventures 
available for free, from the older Zork 
games to Inform and Twine games such as 
Horse Masters, Slouching Towards Bedlam, 
Violet, Galatea, 80 Days, Long Legs and 
more. Visit www.ifarchive.org to find out 
more. But Anchorhead happens to be one 
of the best-written and most-accessible 
interactive fiction games, set in the Cthulhu 
mythos. You’ve moved to a new house and 
new town, but something old and nasty is 
stirring… http://pr-if.org/play/anchorhead/

super Crate box
Vlambeer is the current darling of indie 
development. Super Crate Box is a retro 
single-screen game, resembling the  
original Game and Watch Nintendo 
machines, where enemies fall from the  
top of the screen and crates full of  
weapons spawn randomly. You must  
survive for as long as possible while killing 
enemies using the random weapons. If  
you like this, try Vlambeer’s other games, 
such as Luftrausers or Nuclear Throne. 
http://bit.ly/1I7MVad

PLanETsidE 2
Team Fortress 2 might have the best small team combat in the world, but if you want 
combined arms combat – that is a huge variety of tanks, vehicles, infantry and aircraft – 
then the Planetside series is where you’ve got to go. Players join one of three factions 
fighting across several continents on the huge open world of Auraxis. The FPS combat and 
world layout is smartly done, so players can find themselves in huge battles or playing cat 
and mouse in empty enemy bases. The only caveat is that levelling to get more equipment 
takes some time and the real money kit is rather expensive. www.planetside2.com 

When it comes to 
combat Planetside 
aims for bigger  
and better

The Future  
of Free

Mark Sorrell, from 
Angry Birds  
creator Rovio, 
talks behavioural 
science and 
economics

What’s the state of play of F2P?
F2P is healthy and growing. It’s still 
young and, despite the number of 
entrants to the genre, there is 
surprisingly little innovation or new 
thinking. But make no mistake, the 
biggest games on the planet are free 
to play, and due to the importance 
of network effects in making F2P 
economies work, are strengthening 
their positions over time.

Is there a type of game where the 
paid model still makes sense? 
This depends on how you define 
‘type of game’, but if you have an 
enthusiastic user base, who are 
happy to pay up-front and willing to 
buy further content inside the game, 
then it’s possible to make great 
returns with a pay-up-front system.

The free part of free to play is a 
marketing stunt. Combining the 
large user bases free can provide 
with the variable pricing of an IAP 
economy is how F2P has become so 
dominant – barriers to entry are as 
low as possible and potential upside 
is as high as possible. So paid 
models can still make huge money 
where two things are true. A high 
enough percentage of their total 
market must be willing to pay and 
the game must feature lots of things 
to buy inside the game.

With expensive hardware-heavy 
tech, like VR, does F2P still have an 
advantage, given the consumer-
level financial barriers to entry?
No. VR seems likely to remain a 
novelty for early adopters for a 
significant time to come, and they 
are exactly the sort of user base that 
are easy to market to and willing to 
pay up-front. They are also likely to 
pay a premium for the chance to 
show-off or experience their new 
toy at its best. Alongside that, the 
hardware requirements will shrink 
the market, which makes the social 
drivers behind a lot of F2P spending 
harder to engineer. And then the 
sessioning the hardware demands 
further limits game design. So, 
where F2P will work, it will be the 
League of Legends/Hearthstone 
kind of design, rather than anything 
from mobile.
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 WINDOWS HELP  HARDWARE FIXES  SOFTWARE SOLUTIONS  INTERNET TIPS

Hard drives
WHAT ARE THESE 
MySTERy PARTITIONS? 

Q I was preparing my Sony 
SVE1712 laptop for an upgrade 

to Windows 10 when I came across 
a number of strange drives or 
partitions being listed in Disk 
Defragmenter and then Disk 
Management. There appear to be 
no less than six in total, which 

appear in the following order: OEM 
Partition (260MB), Recovery 
Partition (1.44GB), EFI System 
Partition (260MG), Drive C 
(662.45GB), Recovery Partition 
(450MB), and Recovery Partition 
(33.67GB). Can you help me identify 
these, and why do all of them 
(except drive C) report 100 per cent 
free space?
Maurice Liddle

Graham’s solution
The first two partitions 
in the list are created  
by your laptop 

manufacturer and exist to provide 
recovery options and restore your 
PC to its factory settings if required. 
The EFI partition contains Windows 
boot files, while the final two 
partitions would have been created 
when you updated from Windows 
8 to Windows 8.1, allowing you to 
roll back if you need to. The reason 
the drives appear to be empty in 
Disk Management is that it’s not 
able to read them correctly – use a 
tool like MiniTool Partition Wizard 
(www.partitionwizard.com/
free-partition-manager.html) to get 
an accurate reading. Finally, none of 
this should have an effect on your 
upgrade to Windows 10, which 
should be a smooth experience.

Windows
FIX cORRUPT STORE AND 
APPS WITH A REFRESH 
Q A week ago I had a blue-

screen of death message that 
contained Chinese characters for 

Do you have a  
PC problem?  
Get in touch…
Email full details of your 
problem to the 
support team and we’ll 
do our best to help 
windowsmagazine@
futurenet.com

How big? 
Partition wizard 

provides accurate 
information about 

your drives
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Jargon buster!

some reason. Since that date I’ve 
been unable to access key 
Windows 10 apps (including 
Calculator, Photos and Mail), 
which are all greyed out along 
with the Store app. I tried 
following a series of PowerShell 
commands, but discovered the 
Get-AppXPackage command fails 
right at the end. Can you help me 
resolve this issue?
Jim Thomas

Nick P’s solution
One recommended 
solution is to first  
run the ‘sfc /scannow’ 

command in an elevated 
command prompt – if problems 
are found, but can’t be fixed,  
then trying ‘dism /online /
cleanup-image /restorehealth’ 
should allow you to subsequently 
run the PowerShell command to 
restore the apps.

Unfortunately, Jim received  
an error message when trying  
to run the dism command,  
which indicated a major 
underlying problem. We 
investigated further and 
discovered that refreshing 
Windows 10 should resolve the 
issue – to do this, download the 
Media Creation Tool following  
the instructions at bit.ly/
win10media – when prompted, 
choose the Upgrade option to 
install Windows 10 over the top  
of itself and replace the corrupt 
files, keeping all your apps, files 
and settings when prompted.  
On doing so, Jim was able to 
report the Store and its apps  
were working correctly again.

Hardware
cHOOSING A 10-INcH Pc 

Q I’m in the market for 
something with a screen not 

exceeding 10 inches, but with good 
definition, a touchscreen and 
support for Windows 10. Could you 
help me by suggesting a tablet or 
laptop that would fit these 
requirements and my budget of 
around £300?
William charnley

cat’s solution
Take a look at HP’s 
Pavilion X2 range of 
tablet/laptop hybrids. 

All models boast a detachable 
10.1-inch touchscreen (1,280x800 
pixels). One to look at is the n107na 

Quickfire questions

Find the solution! Microsoft Community
Visit answers.microsoft.com to get answers and elicit fixes from 
official Microsoft support staff and expert volunteers.

An update linked to Flash 
Player appears to have failed. 
Will Microsoft abort this and 
issue one that works?
Bob Sullivan

If updates don’t successfully 
install, it’s best to wait a few 
days – in most cases (as it was 
with this Flash Player update), a 
fixed update will be issued.
 
Is there a way to pin a shortcut 
to System Properties on the 
Start menu in Windows 10?
Joe Pink

No need – instead, click ‘Start’, 
right-click File Explorer and 
choose ‘Properties’ to access it; 
select ‘Manage’ to access 
Computer Management.

“Install Windows 10 over 
the top of itself and 
replace the corrupt files ”

 Elevated mode 
A mode that allows standard 
user accounts to perform 
specific tasks as an 
administrator, giving them 
greater access to the system.
 

 EFI System Partition
A special partition found on 
modern PCs that contains the 
files required to boot Windows. 

RePaiR 
windows 
Perform an 
upgrade 
installation  
to refresh 
windows 10

Regain access 
Make sure your 

username has  
full access to your 

key folders

Support 
Technical help
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2 Switch to Internet Explorer
Now type IE into the Search box  

and click the ‘Internet Explorer’ entry.  
Click the Favourites button, then click the 
arrow next to ‘Add to Favourites’ and choose 
‘Import and export…’ Select ‘Import from a 
file’ and click ‘Next’.

1 Export bookmarks
Open Firefox and press [Ctrl] + [Shift] + 

[B] to open the Bookmarks Manager. Click 
‘Import and Backup > Export Bookmarks to 
HTML…’, browse to a suitable location for the 
bookmarks.html file (which you can rename) 
and click Save.

HOW TO IMPORT FIREFOX 
BOOkMARkS INTO EDGE

Q I was under the impression I 
could import my Firefox 

bookmarks into the new Edge 
browser, but there’s no option.  
Can you provide me with a 
workaround or fix? 
Harriet White

Nick O’s solution
The following 
workaround will work 
with Firefox or any web 

browser that allows you to export 
your bookmarks as a HTML file. 
We’re using Internet Explorer, but 
Chrome works too.

Quickfire questions

click ‘OK’. Tick the ‘Full Control’ box  
under ‘Allow’ and click ‘OK’ – you 
should see the files in the folder 
update, indicating the permissions 
are being updated. Once done, 
James reported the folders were 
behaving properly once again, 
even after rebooting.

Photos
cAN’T EDIT PHOTOS 

Q I recently upgraded my HP 
all-in-one PC to Windows 10, 

but have stumbled on a problem 
with my pictures. When I try to edit 
them, I get a message informing 
me that ‘This file is locked by 
another app at the moment’.  
Could this be related to an app 
(Sony Play memories) that I 
downloaded but uninstalled?
David Potts

Matt’s solution
By the time we 
responded, David had 
managed to find his 

own solution to the problem, which 
he was happy to share with us. He 
opened his Pictures folder in File 
Explorer and went through the 

Is there some quick and 
convenient way I can view 
what add-ins are installed in 
my copy of Office?
kurt Waller

Download Officeins from 
www.nirsoft.net/utils/officeins.
html – it’s a portable tool that 
lets you view all Office add-ins, 
with useful info such as name, 
description and which Office 
program it’s linked to.
 
I can’t seem to boot into Safe 
mode using the [F8] key in 
Windows 10. Can you advise?
David Greecer

Click ‘Start’, then hold [Shift] 
and choose ‘Power > Restart’. 
Windows will reboot to the 
‘Choose an option’ menu – 
from here select ‘Troubleshoot 
> Advanced Options >  
Startup Settings’ and choose 
which flavour of Safe mode  
to employ.
 
I’ve transferred some old audio 
interviews to my PC via 
Audacity – can you 
recommend a tool to help 
transcribe them?
Georgia Illingworth

Try Listen N Write Free 
(elefantsoftware-en.weebly.
com) – it comprises a basic 
media player and text editor, 
and automatically pauses 
every five seconds during 
playback to let you catch up 
with your typing.

x2 model. This comes with 
Windows 10 pre-installed, and is 
powered by an Intel T3 Z8300 
quad-core processor – good for 
browsing, office apps and other 
light use. There’s 2GB RAM and 
32GB flash storage onboard, plus a 
1TB SATA drive. It’ll swallow up all  
of your available budget – a 
cheaper model (the n102na) is 
available for £249 without the 1TB 
drive. Visit store.hp.com/uk and go 
to Laptops then 2-in-1 Detachable 
Laptops to view.

Windows
PERMISSIONS ISSUE 
AFTER UPGRADE 

Q Since installing Windows 10 
I’ve had a problem with both 

my Documents and Pictures 
folders, which prevents me from 
transferring files into either folder. 
I’ve open each folder’s Properties 
and checked the Security tab, 
which shows that I’ve only got 
read-only access, but every time I 
change this to ‘Full control’, it 
reverts back as soon as I reboot my 
PC. Can you please help?
James Gill

Graham’s solution
We asked James to 
check each folder’s 
ownership (click 

‘Advanced’ from the ‘Properties > 
Security’ tab), and he confirmed his 
user account was the owner. He 
then reported which users and 
groups had access: SYSTEM and 
Administrators had full access, 
while HomeUsers had read-only 
access. The problem here was that 
James’ own user account had 
somehow gone missing, so we 
advised him on how to get it back.
Click ‘Edit… on the ‘Properties > 
Security’ tab, then click ‘Add…’ 
Type your user name and click 
‘Check Names’. It should appear, so 

stoP sHaRing 
Unshare a folder if 
its files are locked 
by another app
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Jargon buster!
 

 HomeUsers 
A group of users that is created 
alongside a HomeGroup, 
which contains a list of the 
accounts that have access to 
the files.
 

 SSD
Stands for ‘Solid State Drive’, 
which is a hard drive that 
stores data on interconnected 
flash memory chips. SSD drives 
have no moving parts, and 
transfer data much quicker 
than traditional drives. 

4 Import to Edge
Close Internet Explorer and open ‘Edge’ 

from its taskbar shortcut. Click the menu 
button and select the ‘Favourites’ button. 
Click ‘Import favourites’, make sure Internet 
Explorer is ticked and finally click ‘Import’ to 
complete the process.

3 Import the file
Tick the ‘Favourites’ box and click ‘Next’ 

again. Click ‘Browse’ to locate the bookmarks 
file, then click it to select it followed by ‘Open’ 
and then ‘Next’. Choose where to place the 
favourites and click ‘Import’. Wait, then click 
‘Finish’ when prompted.

“The problem here was that James’ own user 
account had somehow gone missing, so we 
advised him on how to get it back”

various options on the ribbon to 
see if he could find a possible 
solution. He discovered a ‘Stop 
sharing’ button on the Share tab, 
and clicking this resolved the 
problem, allowing him to edit 
photos once more…

Windows
A qUESTION OF 
UPGRADE ELIGIBILITy 
Q I intend to install Windows 7 

from DVD on a new 120GB 
SSD and then upgrade to Windows 
10 on top of that. Issue 114 suggests 
the upgrade will only work if 
Service Pack 1 is installed on 
Windows 7 – is this likely to be on 
my Windows DVD, and if not where 
do I get it? Or can I do a clean install 
of Windows 10 using my Windows 
7 product key and avoid the hassle?
Eric Howman

Mayank’s solution
Unfortunately you’ll 
need to install Windows 
7 SP1 before you can 

upgrade to Windows 10. This only 
has to be done once, though – in 
future, you’ll be able to perform a 
clean reinstall of Windows 10 
directly to the same PC without 
having to install Windows 7 first (or 
worry about a product key). Service 
Pack 1 will be offered through 
Windows Update, or you can 
download SP1 directly from bit.ly/
getwin7sp1 and install it offline. 
Once done, you can upgrade to 
Windows 10 using the Media 
Creation Tool (bit.ly/win10media) 
without having to download any 
additional updates.

Hardware
GRAPHIcS AND SOUND 
ISSUES IN WINDOWS 10 

Q I recently updated my Asus 
A6U notebook from Windows 

8.1 to Windows 10. After upgrading 

I realised there was no sound –  
I immediately entered Device 
Manager and allowed it to search 
for an updated sound driver,  
which it found and subsequently 
installed. After rebooting, it ran for 
a few minutes before crashing with 
the following message: ‘Kmode 
exception not handled rtkvac.sys’. 
In addition, the visuals on the 
laptop are what I’d  
describe as soft. Can you help me 
rectify both problems?
Robert Nesbitt

Nick P’s solution
Unfortunately, the 
prognosis is not good. 
The A6U comes with a 

SiS M661 graphics chipset, which 
isn’t DirectX 9 compatible, and for 
which no driver has been provided 
since Windows XP. Subsequently, 

Robert was stuck with the supplied 
Microsoft Basic Display Adapter, 
hence the soft images – it’s likely he 
was running this driver in Windows 
8.1 too, although the problem 
wasn’t so noticeable there.

The rktvac.sys file is linked to  
the updated sound driver that 
Robert installed, based on the 
Realtek AC97 chipset. A bug was 
found in the drivers and reported 
to Realtek, but seeing as the 
drivers haven’t been updated  
since 2009,  a fix is unlikely to  
be forthcoming, sadly. Robert 
managed to revert to Windows 8.1 
using the rollback function, and 
reported the sound problem  
had been fixed, although he 
continues to suffer from the soft 
image problem caused by the  
fact he’s stuck with the Basic 
Display Adapter. ■

no-fRills 
disPlay the basic 
display adapter 
offers a limited set 
of options

Do you have  
a PC problem?  
Get in touch…
Email full details of 
your problem to the 
support team and we’ll 
do our best to help: 
windowsmagazine@
futurenet.com 
Or write to the support 
team and we’ll do 
our best to help: 
Support Squad, 
Windows Help & 
Advice magazine, 
Future Publishing Ltd, 
quay House, The 
Ambury, Bath  
BA1 1AU

Support 
Technical help
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 new hardware   essential accessories   latest GaMes

here at Windows 
Help & Advice 
we’ve been 
working hard.  
But don’t worry, 

we haven’t been exerting 
ourselves, we’ve been 
letting the tech do that  
for us. First of all, we take  
an extensive look at Dell’s 
Inspiron 15 7000 laptop, a 
computer that feels like it  
was designed specifically  
with Windows 10 in mind.  
Meanwhile HP’s Pavilion  
Mini is one of the best-
looking mini PCs we’ve seen. 
Plantronics BackBeat Sense 
luxury earphones also make 
good, er, sense (and allow us 
to create popular song-lyric 
puns), too. Until next time!

Nick Odantzis deputy editor
nick.odantzis@futurenet.com

Welcome

The Upgrade section is your key to finding out about the latest 
products, all designed to help you get more from your PC

ratinG explained Superb GoodVery good Disappointing Poor

Our promise to you…

You can trust our reviews
Our reviewers are 100 per cent 
independent, with years of 

experience in the world of computing. 
Our rigorous testing procedures mean 
that only genuine, high-quality 
products are awarded high star ratings. 
If you see an item of hardware bearing 
a high score, you can be confident that 
it is an excellent product.

we choose the best products
Thousands of new PC products 
are released every year and 

choosing between them can be an 
impossible task. Our experts select only 
the best hardware and software to 
feature in this magazine. Even better, 
our star rating system makes it simple 
to find the best products, giving you  
a fast, trustworthy guide.

84 HP Pavilion Mini
One of the best-looking mini PCs we’ve seen 
– a Windows-toting answer to the Mini Mac?

80 Dell Inspiron 15 7000
A computer that feels like it has been  
designed specifically around Windows 10

82 Sony MP-CL1
A portable projection option that comes  
in a wonderfully tiny package

86 Plantronics BackBeat Sense
BackBeat, the word is on the street that 
these headphones are worth a shout

how we review
Our expert reviewers guarantee  
to test every piece of hardware 

rigorously and thoroughly, using  
only acknowledged experts to 
establish the worth of a product.  
We always review from the viewpoint 
of our readers; the day-to-day 
practicality and quality of a product  
is paramount.
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Dell’s Inspiron 15 feels like a 
computer that has been 
designed specifically around 

Windows 10. It functions nicely as 
a laptop, and does an admirable 
job in tablet mode. Switching 
between the two configurations 
allows Windows 10 to ask if you’d 
like to switch back and forth 
between the two modes. In either 
configuration, the Inspiron does 
well, but with a few exceptions,  
it’s much more useful as a laptop 
than as a tablet.

With its brushed-aluminum 
interior finish and backlit, chiclet 
keyboard, this laptop could easily 
be mistaken for a MacBook.

The trackpad is set in with a 
smooth, bevelled border that 
highlights the change from the 
aesthetically pleasing surface in a 
sleek, but striking way. This border 
carries over to the outside edges 
of the laptop’s aluminum interior, 
which is milled with a subtle angle, 
adding a fashionable design 

element to the otherwise 
industrial keyboard deck.

On top of the clean finish, the 
aluminum makes the machine feel 
solid. No matter how you hold it – 
in one hand or two – the laptop 
never feels like it’s straining under 
its own weight, which is a good 
thing, considering the machine 
weighs close to 2.2kg.

The keyboard itself is lovely, 
with wobble-free keys spaced 
perfectly and a satisfying amount 
of travel. The keyboard lights up as 
well, depending on the ambient 
light, which is another nice touch 
on top of also being spill-resistant.

Converted
When converted to tablet mode, 
there isn’t much that jumps out. 
It’s just a large (and colourful) 
bright screen. Dell did include a 
Windows button on the bottom of 
the screen, which is handy for 
quickly accessing the tablet-mode 
Start screen – but that’s all there is 

to get excited about when you 
have the Inspiron 15 converted.

The keyboard and brains of the 
computer sag a little on the hinge 
when folded into tablet mode, so 
gravity opens it up just slightly. 
There’s no satisfying catch or 
magnetic clasp to hold the hefty 
halves together. It’s just enough 
give to raise doubts on how well 
the hinges will hold up after 
repeated use.

However, for full-page or 
endless scrolling websites, the 
15-inch screen in tablet mode 
suddenly turned into something 
we found indispensable. The same 
applied to PDF documents.

The Inspiron 15 7000 Series 
2-in-1 is a sweet deal. For the price, 
you get an Intel i5-5200U 
processor, which performs well 
under normal use. The chip is able 
to keep up with Windows 10’s 
streaming from Xbox One feature, 
and we played a few games 
without any problems.

Dell Inspiron 15 7000
£580 | $899 www.dell.com

An attractive 2-in-1 that’s more laptop than tablet
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achieve one-handed without 
propping it up on something.

The build and screen quality are 
fantastic and make the Inspiron 
look like a higher-end computer 
when open. The keyboard is 
wonderful, with solid keys and an 
intelligent backlighting system. 
For everyday use, it’s adequately 
powered and the SSD option 
makes it feel nice and peppy from 
startup to file searching. In fact, it 
feels like a laptop first. The extra 
screen space is welcome in tablet 
mode, but it’s too big for your lap.

This Inspiron is a fine machine 
that would make a great laptop for 
professionals or students looking 
for a versatile device. ■

A capable 2-in-1 notebook  
that definitely works better  
as a laptop than as a tablet.

However, streaming from the 
Xbox One and lightweight gaming 
is all you’re going to get out of 
the Inspiron 15. Minecraft works 
fine, but we wouldn’t recommend 
trying to play Metal Gear Solid V 
with it. 

There is no dedicated graphics 
chip. That’s a shame, given that 
the 1,920 x 1,080p full HD (FHD) 
screen looks great. It’s crisp and 
colourful, with high-resolution 
images and HD movies looking 
lovely displayed on it. However, we 
didn’t like the auto-adjusting 
brightness feature much, but we 
were able to shut it off.

The setting was too sensitive, 
and merely moving our hand in 
front of the front-facing camera 

would cause the screen to pump 
up the brightness suddenly, only 
to drop it back down again a 
second later. It was too jarring to 
be useful.

In the bag
The Inspiron 15 is impressive  
when it comes to storage with a 
256GB solid-state drive (SSD). 
There are also optional 
configurations with hard drives 
available in 500GB or 1TB. 
However, those will add about a 
tenth of a pound to the Inspiron’s 
already heavy weight. 

The Inspiron 15 performs well in 
everyday tasks. Web surfing, movie 
viewing and streaming from Xbox 
One work nicely. The i5 processor 
is capable enough to handle 

photo-editing without any hiccups 
or slow performance.

Watching a movie on a 
continuous loop at 50% brightness 
and volume, the Inspiron’s battery 
lasted an adequate 5 hours and 16 
minutes. That’s almost enough to 
relieve the boredom of a flight 
without needing to swap to a 
different device. Still, that’s not 
fantastic and well short of Dell’s 
claim of nearly 9 hours.

But in spite of some 
performance shortcomings, the 
Inspiron looks and feels so nice, 
especially for the price. It makes a 
strong standing in its class.

The speakers output a clear, 
distortion-free sound that doesn’t 
fall to pieces in the mids and lows, 

something you might not expect 
out of a mid-range laptop. 
Watching movies on the Inspiron is 
a treat, given its wide, vibrant 
display, and it’s good for in-car 
entertainment on road trips.

But don’t bother trying to use 
the Inspiron 15 outside. Its 
reflective screen made it 
impossible to see anything, even 
on a slightly overcast day at 
maxmium brightness.

Final verdict
The laptop is sturdy enough that 
you’ll never feel like you need to 
hold it in a special way to keep it 
from being damaged, but opening 
it does require both hands and a 
firm grip. Its weight and size mean 
tablet mode can be difficult to 

“For full-page or scrolling websites, the 15-inch 
screen in tablet mode became indispensable”

Upgrade 
Dell Inspiron 15 7000
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KEY FEATURES

Dell Inspiron 15 7000
Operating system Windows 10
Processor 2.2GHz Intel Core i5-5200U 
(3MB Cache, up to 2.7GHz)
Storage 256GB SSD
RAM 8GB DDR3L  
(1,600MHz, single channel)
Graphics Intel HD Graphics 5500
Optical drive Optional external DVD-RW 
(not included in configuration)
Connectivity Intel Centrino Wireless AC 
7265, Bluetooth 4.0
Ports HDMI 1.4a, 2 USB 3.0 (one with 
PowerShare), USB 2.0, Noble lock slot, 
media card (SD, MMC) 
Weight 2.14kg 
Screen size 15.6-inch LED backlit  
Truelife display with FHD resolution 
(1,920 x 1,080) 
Camera Integrated widescreen  
720p webcam with dual digital 
microphone array



Sony’s latest entry into the 
projector space is here, and it 
comes in a wonderfully tiny 

package. The MP-CL1 is Sony’s first 
pico projector, offering an 
extremely portable projection 
solution for users on the go. 

If you’re always on the road,  
the MP-CL1 combines a number  
of features that make it a 
particularly attractive option for 
impromptu presentations. 
Especially as it’s only 210 grams.

But despite its small size, the 
MP-CL1 still manages to pack in 
handy features such as Wi-Fi 
connectivity and laser projection 
with autofocus. The only place 
where the MP-CL1 appears to  
be lacking in comparison is when  
it comes to its weedy lumen count 
of just 32.

On paper, the MC-PL1 looks like a 
great contender in the portable 
projector space, but we’ll now take 
a closer look at its performance, 
look and feel.

The projector comes packaged in 
a fairly nondescript black, book-like 
box simply emblazoned with the 
Sony logo up front. The thick, 
smooth stock combined with a 
magnetic hinge makes for a 
premium feel that rivals Apple’s 
attention to packaging detail.

And that premium feel carries 
over to the projector itself. The 
chassis comprises mainly matte 
black aluminum, with the only 
plastic appearing in the front and 
back of the device. The 
construction feels sturdy, with the 
only point of contention being 
those two plastic pieces, which 
have the potential to be trouble if 
the projector is dropped.

The top of the MP-CL1 is adorned 
only with a Sony logo at the back, 
along with power and battery 
indicators at the front. The right 
side of the projector is made up of 
smooth, unbroken aluminum, while 
the left side features one USB port, 
a 3.5mm audio jack, a mini HDMI 

port, a micro USB charging port, 
and buttons for power and moving 
around menus.

On the front of the MP-CL1, you’ll 
find another Sony logo, along with 
the recessed projector lens. Moving 
to the bottom,  you’ll find the 
speaker grille.

It’s the little things
And now for the real draw of this 
gadget – its size. Upon first look, it 
would be easy to mistake the 
projector for a slightly overgrown 
smartphone. The MP-CL1 measures 
in at a very pocketable 77 x 149.5 x 
13mm. It features a laser projection 
system that is rated at just 32 
lumens and projects in a rather odd 
native resolution of 1920 x 720. 
Although the MP-CL1 won’t win 
any awards for its brightness, the 
laser projection system can make 
for a sharper image with no need 
for manual focus controls.

It also sports a contrast ratio of 
80,000:1, a 3000mAh battery rated 

Sony MP-CL1
£229 | $349 www.sony.com

The smartphone-sized projector that packs a lot of punch
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we think they’re worth the tradeoff 
for its sheer portability.

Final verdict
Due to its diminutive stature, the 
Sony MP-CL1 is perfect for anyone 
giving presentations on the go. You 
can simply slide it into your pocket 
and walk out the door – no bag 
necessary. Add in a premium feel 
and attractive design, and this 
projector really gives it some and 
may earn you some compliments at 
your next presentation.

Connectivity is limited to mini 
HDMI and wireless display 
mirroring, but that seems like a 
perfect tradeoff for extreme 
mobility. The included mini HDMI 
to HDMI dongle eliminates the 
need to purchase any additional 
accessories, and display mirroring 
allows you to simply connect your 
smartphone and go.

But, the extreme portability of 
the MP-CL1 doesn’t come without 
its drawbacks as you still need an 
HDMI cable if you don’t have a 
device compatible with the wireless 
display mirroring. 

Sony’s MP-CL1 offers great  
value for those looking for an 
extremely portable projector. 
Between its sharp, laser-projected 
picture, wireless connectivity and 
price, the MP-CL1 seemingly beats 
out similar small form factor 
projectors in its price range. As long 
as you’re willing to acknowledge 
the MP-CL1 isn’t meant to compete 
with the big kids in the projector 
space, its few shortcomings are 
easy to look past, especially when 
considering its portability.

The Sony MP-CL1 provides a 
sharp, clear picture in an 
extremely pocketable form factor. 

at  two hours, and the ability to 
mirror a smartphone or tablet over 
Wi-Fi. Along with an HDMI 
connection that is MHL compatible, 
this means you can connect 
practically any other HDMI device 
for streaming and mirroring over a 
hardwired connection.

What a performance
It may be a bit surprising 
considering its small form factor, 
but the MP-CL1 sports some 
impressive image quality. Upon 
booting the projector up for the 

first time, colours were fairly poppy, 
but we found the picture to be a 
tad warmer than we’d have liked. 
The colours weren’t far off, and it’s 
mostly a subjective matter, but a 
quick jaunt to the settings menu 
allowed for a bit of tinkering. 

One nice feature of the MP-CL1’s 
laser projection system is its 
autofocus. Often, a frustrating 
aspect of setting up a projector is 
dialing in the proper focus settings 
so text and images pop. With the 
MP-CL1, there’s no need for a focus 
control, and the projector kept 
everything in proper focus no 
matter how far we moved it from 
the projection surface.

The MP-CL1 sports two main 
connectivity options: mini HDMI 
and Wi-Fi for wireless display 

mirroring. HDMI performed as 
you’d expect, properly handling 
anything we threw at it. Similarly, 
display mirroring over Wi-Fi was as 
simple as casting to the MP-CL1’s 
ad-hoc network from a compatible 
device. You can project documents, 
videos, and more from your device 
– essentially using your smartphone 
as a presentation clicker.

Speak up
Although the MP-CL1 performs 
exceptionally well when it comes to 
picture quality and performance, 

one particular pain point is its 
speaker. It’s definitely 
understandable given the 
projector’s small stature, but sound 
quality and volume out of the 
single speaker on the bottom of the 
device leaves a lot to be desired. 
The 3.5mm headphone jack will get 
a lot of play with headphones or 
external speakers.

Sony estimates the MP-CL1 will 
fetch around two hours of 
continuous projecting time. We 
found this to be about right, with a 
couple of tests involving streaming 
video and device mirroring coming 
in around the two-hour mark.

The Sony MP-CL1 has a lot to 
offer in a package that’s not much 
bigger than your average phablet. 
Yes, it has some major flaws, but  

“It may be surprising considering its small form 
factor, but it sports some impressive image quality”

Upgrade 
Sony MP-CL1 projector
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KEY FEATURES

Sony MP-CL1 projector
Projection system Laser
Resolution 1920 x 720
Brightness 32 Lumens
Contrast ratio 80,000:1
Projection size Up to 120”
Video inputs Mini HDMI, USB 
Audio outputs 3.5mm jack 
Dimensions 3.0 x 5.9 x 0.51 inches 



T he market for small-footprint 
PCs has grown considerably 
and now offers a wide range 

of options. The HP Pavilion Mini  
is one of the latest small, quiet  
and energy-efficient desktops 
around. It’s also one of the 
nicest-looking mini PCs we’ve 
seen since the Mac Mini.

Our review model came with  
an impressive 1TB of storage 
space (500GB is also available),  
a 1.9GHz Intel Core i3 processor 
and 4GB of RAM (which can be 
upgraded to 16GB if so desired). A 
faster i5 model is also available, as 
is a lower-priced option with a less 
capable Pentium 3558U processor 
and smaller 500GB hard drive.

Although the graphics may not 
be up to the task of heavy-duty 
video-editing or gaming, the 
Pavilion Mini offers plenty of 
connectivity for such a small 
package, making it an attractive 
proposition for light users at 
home or in the office.

Weighing only a little over  
660g and with a diminutive 
footprint of 144mm x 144mm x 
52mm, if you didn’t know any 
better you could easily confuse 
the Pavilion Mini for an external 
hard drive or Wi-Fi router.

The design favours the 
combination of shiny white and 
semi-translucent plastics over 
utilitarian aluminium bodies you’ll 
find on many other Mac clones. 
With miniature proportions and 
not a square corner in sight, the 
Pavilion Mini is a cute little 
machine that would grace even 
the coolest of workspaces.

Up front there are twin USB  
3.0 sockets alongside the power 
button, while on the right there’s 
a handy SD card slot for easy 
photo access. On the rear there 
are two more USB 3.0 ports 
alongside a HDMI, DisplayPort, 
RJ45 Network, 3.5mm combined 
headphone/microphone and DC 
power sockets.

The underside is covered in  
a rubber pad which stops the 
Pavilion Mini sliding around, 
which can be removed to enable 
access to the screws you’ll need  
to undo in order to access the 
internals. Our model had the 
capable 1.9GHz i3-4025U 
processor rather than the bog-
standard Pentium 3558U some 
models are stuck with.

A little bit more
Alongside the base model and  
the model we reviewed, HP also 
offers a nippier Mini in the form  
of an i5-5200U coupled with  
8GB of RAM, rather than the 4GB 
in our model. 

Depending on where you 
purchase the Pavilion Mini from, 
you may find a HP-branded 
keyboard and mouse thrown in, 
although it’s a pretty cheap 
wireless combo that doesn’t 
exactly match the Pavilion Mini’s 
Apple-esque aesthetics.

HP Pavilion Mini
£250 | $269 www.hp.com

Is this the Windows-toting answer to a Mac Mini?
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hoped for more apps that play  
to the potential qualities of a 
miniature PC as a home streaming 
hub or cloud computing 
companion, rather than the 
numerous awful games.

The final verdict
If you’re looking for a mini 
computer to look natty in the 
office, sit surreptitiously under 
your TV or meet the compact 
requirements of a kid’s homework 
needs, then the HP Pavilion Mini  
is a smart contender.

While the base specification 
may not meet the requirements  
of most semi-serious gamers or 
the demands of more intensive 
tasks, the higher-end model more 
than meets the needs of those 
looking for a home entertainment 
computer, and it’s priced 
favourably against others.

The mid-range specification  
of the model we reviewed 
compares favourably against 
similarly priced but less powerful 
competitors. The good looks also 
make it a smart Windows 
alternative to the Mac Mini. ■

It won’t tear through intensive 
tasks, but the price, specs and 
style make it an attractive option.

The Pavilion Mini comes loaded 
with Windows 8.1, and can easily 
be upgraded to Windows 10. 
While Windows 8 may not have 
been everyone’s operating system 
of choice, the second iteration of 
Microsoft’s outgoing OS copes 
well on lower-end configurations 
such as this, even if it generally 
feels like it’s more suited to 
touchscreen interactions.

HP has never been one for 
offering its PCs with a barebones 
Windows install, and an almost 
obese range of applications are 
pre-installed, many of which you’ll 
likely want to uninstall straight 
away. McAfee’s suite is the 

antivirus of choice (though it is 
just a trial), while a selection of 
CyberLink media applications offer 
photo and video playback and 
light editing.

Keeping it casual
A large number of casual games 
are also ready to play from 
WildTangent, although you won’t 
find any triple-A titles here. The 
best of the bunch is probably 
Plants vs Zombies, although many 
may consider even this a waste  
of valuable storage space. 

Other Windows 8 apps such  
as TripAdvisor, The Weather 
Channel, Evernote and others are 
frankly bloatware.

With an increasing selection of 
small form factor PCs, this market 

is becoming an increasingly tough 
one for any one brand to 
dominate. Looks, price and 
performance vary wildly, and  
HP caters for a range of price and 
performance requirements with 
the Pavilion Mini, while also 
rivalling Apple products for looks, 
even if it’s of plastic construction 
rather than Cupertino’s trademark 
sleek aluminium.

The Pavilion Mini is a compact 
package that looks the part, and 
could happily find itself either at 
home fulfilling the job as a media 
portal or homework PC, or in the 
office, crunching through office 
documents with ease.

HP has spread itself widely with 
the range of specifications on 
offer, with a £249.99 starting point 
seeming pretty competitive in 
light of the competition from Acer 
and Apple. Compared to some 
competitors, the variety of ports 
and plentiful USB connections  
is a pleasant surprise for such  
a small form factor.

HP has crammed an awful lot 
into this compact package, and 
despite the multiple ports on offer 
upgrade options are very limited. 
The only component you could 
consider upgrading is the RAM, 
and doing this requires exposing 
the delicately stacked innards.

The bundled selection of 
software was thoroughly 
uninspiring. We would have 

“A compact package that looks the part and could 
happily find itself either at home or in the office”

Upgrade 
HP Pavilion Mini
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KEY FEATURES

HP Pavilion Mini
Operating system 64-bit Windows 8 
(upgradable to Windows 10)
RAM 4GB 1,600MHZ DDR3 SDRAM
Processor 1.9GHz Intel Core i3-40255U
Storage 1TB 5,400rpm HDD
RAM 4GB 1,600MHZ DDR3 SDRAM
Graphics Intel HD Graphics 5500
Ports 4 x USB 3.0, HDMI, DisplayPort, 
headphone/microphone jack, SD Card
Connectivity Bluetooth 4.0, 802.11n 
Wi-Fi, Gigabit Ethernet
Size 144mim x 144mm x 52mm
Optical drive N/A



Plantronics isn’t a manufacturer 
you would normally associate 
with headphones. The brand 

made its name in the Bluetooth 
portable headset market and 
making the jump from business-
centric devices to a consumer 
market where, increasingly, design 
is as important as sound quality,  
is a tough ask.

This is Plantronics second stab  
at over-ear headphones. The first 
was 2014’s Plantronics BackBeat 
Pro. While sound quality was 
exceptional, the headphones were 
bulky and heavy, really made for 
home or office use – and this meant 
they were pricey, too.

Seeing the light
All of these niggles have been 
rectified in its latest headphones, 
the superb Plantronics BackBeat 
Sense. These wireless headphones 
not only look lovely, they are some 
of the lightest cans we’ve ever 
tested – weighing just 141g. They 

are seriously light, which means 
you can wear them pretty much all 
day without any discomfort.

They come with extra-
comfortable padding. Super-soft 
leatherette material sits on the 
stainless steel headband and covers 
the memory-foam ear pads. They 
feel and look great, don’t warm up 
your ears like some ‘phones and 
there’s definitely no pinching to be 
felt. There’s also a nice design 
flourish in the ear pads – each one’s 
sound holes have been shaped in 
either an L or an R to denote which 
way to wear the headphones.

A pair of sturdy plastic arms lead 
down to the circular controls on 
both the left and the right of the 
devices. The design of the controls 
will be familiar to anyone who has 
used a pair of Philips Fidelio 
headphones – everything is well 
laid out and easy to use.

On the back of the left ear cup, 
there’s a rubber clickable button 
with Play/Pause functionality in the 

middle and skip left and right along 
the sides. The volume rocker is on 
the left-hand side and there’s a nub 
on the top you flick forward and 
back to adjust volume. 

What a carry on
The right ear cup houses a power 
button and the ability to take or 
cancel calls. Underneath is a 3.5mm 
jack for those that want to be 
tethered and a microUSB slot for 
charging. In the box you get a really 
nice carry case and a microUSB lead 
for charging the headphones, as 
well as some cable – in case you run 
out of battery.

The BackBeat Sense are wireless, 
which means you can attach them 
to a mobile device through 
Bluetooth – and pairing is simple. 
You can have two things attached 
simultaneously. The headphones 
use Bluetooth v4.0 and just to show 
off its prowess in this area, 
Plantronics’s signal reaches up to 
330 metres –10x the normal range.

Plantronics BackBeat Sense
£127 | $196 www.plantronics.com

BackBeat, the word is on the street that Sense headphones are worth a shout
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hours and we managed to squeeze 
around that per 2.5-hour charge. 
For some reason, the battery icon 
for the device, on our LG G4, never 
looked much more than half full, 
though, which irked. But you can 
hard-press an ear cup for a battery 
status update, via LED lights.

The final verdict
Plantronics isn’t a big name in 
headphones, but it should be.  
The BackBeat Sense design is  
sleek, offering a nice lack of 
bulkiness. They are among the 
most comfortable headphones 
we’ve worn and the lightest of their 
type. They’re simple to setup and 
while sound isn’t perfect, for the 
price it’s expansive and loud. 

If only Plantronics could do 
something about the audible 
sound you hear when walking, it 
would have an unbeatable range.
For now, it’s a fantastic, noticeably 
loud, step in the right direction.

A great-looking, lightweight 
over-ear Bluetooth offering  
– if only the sound was better.

Given that Plantronics is well 
known for being the makers of the 
mic that Neil Armstrong spoke his 
famous ‘One small step’ speech 
into, we decided to listen to Public 
Service Broadcasting’s The Race For 
Space. The track Go! really tested 
the BackBeat Sense. The bass 
offered up a crisp rumble, while the 
mid tones never sounded muddled.

The songs that sound best are 
those that warrant a clean sound 

and aren’t too bass driven. Mercury 
Rev’s The Light In You sounded lush 
with great dynamic range, but 
some bass-heavy Kendrick Lamar 
didn’t have the bite we were 
expecting. The sound is well-
rounded, however, and it’s nice to 
hear over-ear headphones not 
tuned primarily to drive bass.

Volume was decent too, 
sounding much louder than many 
Bluetooth headphones we’ve tried 
– this has always been a bugbear, 
but the BackBeat Sense perform 
admirably. Some of this can be 
attributed to the addition of the 
aptX codec, with which the 
BackBeat Sense are compatible.  
It also makes sense that the Sense 
range acts as Bluetooth headset 
too. The calls we took were really 

clear, but then the company thrives 
in this area already.

There were a couple of niggles, 
though. While sound clarity was 
superb, these aren’t as noise 
cancelling as their bedfellows. 
Wearing them on the ever-loud 
London commute – which for me  
is a walk, a bus, a train, a bus, a walk 
– outside noise was only really cut 
to about 50 per cent. The cans just 
didn’t do enough to drown out the 

man apologising to his wife about 
forgetting her mother’s birthday.

On the flip side, noise leakage is 
minimal. Colleagues next to you 
won’t know you’re listening to 
Shania Twain, even on high volume. 
And they won’t hear Shania when 
you take them off either, as the 
‘phones automatically stop playing 
when removed. And re-start when 
you raise them to your ears. 

The biggest issue we had was 
when walking with them on. 
Because they are so light and the 
leatherette band acts as suspension 
for the headphones when worn, 
they creak and offer up a slight 
pounding sound when your feet  
hit the pavement.

Battery life was impressive 
throughout. Plantronics quotes 18 

“It feels and looks great, doesn’t warm up your ears 
like some ’phones and there’s no pinching felt”

Upgrade 
Plantronics BackBeat Sense
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KEY FEATURES

Plantronics BackBeat 
Sense
Supplier www.plantronics.com
Bluetooth Profiles Bluetooth  
v4.0 + EDR, A2DP, AVRCP, HFP 1.6 
wideband, HSP 1.2
Battery Power Up to 18 hours wireless 
streaming, 21 days standby time, 180 
days in DeepSleep mode*, up to 18 hours 
wireless streaming, 21 days standby time, 
180 days in DeepSleep mode*
Battery Type Rechargeable, non-
replaceable lithium-ion 
Charge Time Up to 2.5 hours
Noise-cancellation Passive noise 
blocking, digital signal processing (DSP) 
and dual microphones
Voice Alerts Spoken alerts in 14 
language options 
Wireless Range Up to 100 metres/330 
feet from phone or tablet with Class 1 
Bluetooth 
Multi-Point Simultaneously connect 
two Bluetooth devices (2H2S) 
Weight: 141g
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Words: Danny Phillips

HIGH-RES  
AUDIO PLAYERS
Blast high-res tracks on 
your travels with these 
pocket-sized players that 
take sound quality to 
sparkling new heights

lowly but surely, high-resolution  
audio is shaking up the music 
industry, giving us the chance to hear 

our treasured tunes just as the artists intended.  
With high-res, detail is clearer, vocals are more 
life-like and bass is, er, bassier.

With support for high-res formats such as  
FLAC, ALAC, WAV, AIFF and DSD, these pocket 
players pipe better-than-CD-quality tracks  
into your ears – up to 192kHz/24-bit  
in most cases – and throw in other  
goodies such as Wi-Fi, Bluetooth 
and top-notch audio 
components that tease out the 
extra sonic depth and detail. 

To experience high-res audio to 
the fullest, you need a pair of high-
quality headphones that can reveal the 
subtleties of the music. We tested these  
players using OPPO’s sublime PM-3s  
(£350, oppodigital.com).

S

2

1 Sony NWZ-A15
£170 sony.co.uk

Sony’s entry-level player isn’t quite the 
cheapest here, but the lightweight 
build and physical menu buttons make 
it feel that way. No Wi-Fi means no 
streaming or apps, but there is 
Bluetooth aptX, NFC, FM radio and 
16GB of built-in memory (microSD 
cards are supported). Its diddy size 
slips nicely into the pocket, and the 
2.2-inch screen is easy to read. The 
Sony plays Lose Yourself To Dance by 
Daft Punk with deep, rumbling bass 
and glittering detail, but it lacks the 
dynamism of better rivals. On the plus 
side, Sony’s claimed 30-hour battery 
life is remarkable.

3 Cowon Plenue M
£540 cowonglobal.com

The Plenue M is a scaled-down version 
of Cowon’s pricier Plenue 1, but it 
remains beautifully built and stuffed 
with high-end features. There’s  
a Burr-Brown DAC, noise-reduction 
tech and support for all the high-res 
formats, like FLAC, ALAC, DSD and 
even DXD. Battery life is 11 hours, and 
there’s 64GB of built-in storage 
(expandable with a microSD card), but 
there’s no wireless. The 3.7-inch 
touchscreen is sharp, but top of the bill 
is its performance – through our cans, 
the Cowon makes high-res tracks 
sound weighty, dynamic and 
staggeringly detailed.

2 Acoustic Research 
AR-M2
£900 acoustic-research.com

The metal M2 is a well-built player, but 
the volume wheel is too easy to turn 
by mistake. The basic Android OS (4.3) 
looks great on the five-inch screen, 
while Wi-Fi and a web browser are a 
bonus. The 64GB of built-in storage 
can be expanded with a microSD card, 
and it plays every high-res format up 
to 192kHz/24-bit, including niche stuff 
like DSD and DXD. Leave the Sound 
Effects menu alone and sound quality 
is astonishing, offering greater bass 
punch, but the nine-hour battery life 
isn’t as long as some.
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3

6 PonoPlayer
£260 ponomusic.com

The brainchild of high-res champion 
Neil Young, the PonoPlayer stands out 
from the crowd. Kudos for the quirky 
pyramid design and tactile rubber 
finish, but it’s too chunky to fit 
comfortably in the pocket. Like the 
other players, it supports all the 
high-res formats and offers 64GB of 
internal storage, expandable by 
microSD, while the two-inch 
touchscreen is low-res but responsive. 
In action, it handles the high-res 
version of Young’s Heart Of Gold with 
abundant detail and dynamics (as 
you’d expect!), but the quoted 
eight-hour battery life is disappointing.

4 Astell&Kern 
AK120 II
£1,499 astellnkern.com

With its precision-engineered 
bodywork and suave styling, this is the 
player Bond would choose. The sharp 
3.3-inch touchscreen makes navigation 
a cinch. On-board memory is the most 
capacious here (128GB), and this can 
be doubled with a microSD card. It 
also offers balanced headphone 
outputs and dual DACs, and plays any 
high-res format up to 192kHz/24-bit. 
There’s Bluetooth and Wi-Fi, but it only 
connects to A&K’s PC software. Sound 
quality is amazing, with pristine detail 
and full-bodied bass.

5 Fiio X3  
(2nd Generation)
£159 fiio.net/en

Fiio’s revamped X3 is the most 
affordable player here, but you 
wouldn’t know it from the robust 
aluminium chassis and feature list. A 
full-colour interface greets you on the 
two-inch screen, but the jittery jog 
wheel betrays the budget price. 
Features are terrific for the money, 
including DSD decoding, 11-hour 
battery, a Cirrus Logic DAC and dual 
crystal oscillators, but there’s no 
built-in storage. The price doesn’t 
impact on sound quality – you hear 
every detail, while the bass is punchy.
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 windows 10 tips   installation advice   get going with a new pc

Welcome
Whether you’ve 
just installed 
Windows 10,  
or you’re still 
wondering if it’s 

worth the upgrade, then 
you’ve come to the right 
place. Windows 10 can be  
a leap into the unknown for 
some people, and we’re here  
to give you the confidence to 
take the initial steps. 

In this section, you’ll find 
advice on how to upgrade to 
Windows 10, as well as a short 
tutorial showing how it works 
and what you need to do first. 

And don’t forget to let us 
know how you’re getting on! 
Email us on windowsmagazine@ 
futurenet.com.

Matt Hanson  
Associate Editor 

Featuring…

windows 10 tip of the month Change your background picture

The default Windows 10 background 
picture is a little, shall we say, on the  
dark side? You can brighten things  
up by choosing one of the other default 
backgrounds, or you’re free to use any 
picture you like, including one of your 
own photos. You’ll find the 
Personalisation options to do all this  
in the Settings app, which is accessible 
from the Start menu. Here’s how to 
update your background.

Update your background picture

Windows 10

Find tHe settings From the start menu choose 
settings, then Personalisation, then Background

BrigHten uP Choose a different background  
picture or click Browse to use your own photo

Welcome to…

www.facebook.com/windowsmag

Turn To  
page 12 

for more 
windows 10 

help
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92 Installing Windows 10 is easy to 
do – read our no-nonsense guide 
for all the tips and advice you need

 
 

94 With your operating system 
installed, we show you how to get 
started with the new features

page://92
page://94
page://12


W
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WindoWs 10    
Bring your PC up to date with the latest version of Windows 10 

– it could be the last time you’ll ever upgrade…
indows 10 offers 
many new features 
and improvements 
from previous 

versions. Features include 
Cortana and the Edge web 
browser, as well as Windows-
standard security tools, such as 
secure boot and Windows 
Defender. If you’re currently 
using Windows 7 Starter, Home 
Basic or Home Premium, or the 
standard Windows 8.1, this is 
the version you’ll get as part of 
your free upgrade.

Windows 10 Pro is designed 
for more advanced operation, 
and includes a few more 
features, including the ability 
to host a Remote Desktop 
session, additional data 
security with Bitlocker and the 
Encrypted File System (EFS), 

Installing

additional networking 
components, and Hyper-V, 
which allows the creation of 
virtual machines. 

Windows 10 is also making 
its way to mobile devices with 
the Mobile and Mobile 
Enterprise editions, which will 
replace Windows Phone 8. 

Get installing
Installing, as you’ll find out, is 
reasonably straightforward. 
Upgrading from within 
Windows is even easier. In our 
testing, we lost no files or 
installed programs, although 
you may see a few default 
Windows apps disappearing – 

Windows 7’s Solitaire and 
Hearts, for example, will not 
transfer because Windows 10 
has its own versions. 

Windows 10 maintains a 
high level of compatibility with 
previous versions, and we’re 
yet to encounter any software 
that doesn’t work as it did on 
the Windows 8.1 desktop.

If you’re eligible for the free 
upgrade – that is, if you’re 
running a licensed copy of 
Windows 8, 8.1 or 7 with at 
least Service Pack 1 installed – 
you’ll see a windows logo in 
the taskbar at the bottom-right 
corner of your desktop. Click to 
get Windows 10 for free. 

But there’s more than one 
way to upgrade, and several 
things to bear in mind when 

you do so. Here we cover 
everything you need to know!

Back up first
While it’s unlikely anything will 
go wrong, a new install is a 
good excuse for a backup! Safe 
data should be stored in its 
original location, with copies in 
two other different locations. 
You will need to use an 
external drive and online cloud 
storage. Most free services 
offer a limited amount of 
space, so only place your most 
critical files here. Services such 
as Carbonite or CrashPlan, 
which charge a subscription 
fee, offer more options, and do 
the hard work for you.

The key location to have 
backed up is your personal 
folder, which will sit within the 
Users folder on your main 
drive. This includes your 
libraries – Documents, Photos 



Windows 10 
Installing
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Windows 10 
keyboard 
shortcuts
1. [Alt]+[Tab]
Switch between open apps

2. [Alt]+[F4]
Close the active item, or exit 
the active app

3. Windows logo key+[L]
Lock your PC or switch 
accounts

4. Windows logo key+[d]
Display and hide  
the desktop

5. Windows logo key+[A]
Open Action center

6. Windows logo key+[s]
Open search

7. Windows logo key+[C]
Open Cortana in  
listening mode

8. Windows logo key+Tab
Open Task view

9. Windows logo 
key+[Ctrl]+[d]
Add a virtual desktop

10. Windows logo 
key+[Ctrl]+Right arrow
Switch between virtual 
desktops you’ve created on 
the right

11. Windows logo 
key+[Ctrl]+ Left arrow
Switch between virtual 
desktops you’ve created on 
the left

12. Windows logo 
key+[Ctrl]+[F4]
Close the virtual desktop 
you’re using

and the like – and your 
Windows desktop. But do be 
warned it won’t cover 
absolutely everything safely.

There’s a small chance you’re 
very organised, and you know 
where every file of a given type 
resides on your hard drive. 
There’s a larger chance 
everything is scattered in 
separate places, so you’ll need 
to dig everything up. Use 
Windows’ search facility to find 
what you’re looking for; open 
up Computer in an Explorer 
window and use the search bar 
at the top to search for, for 
example, ‘*.jpg’ to find all of 
your photos, or ‘*.mp3’ for your 
music. Select the files from 
your searches and copy them 
to your external drive and, if 
you have space, to your chosen 
cloud service.

Time to upgrade
To upgrade to Windows 10, just 
click the icon in your System 
Tray and proceed. Or, you 
might want to do clean install. 
If you have a copy of Windows 
10 on DVD, put it in your 
optical drive, restart your 
machine, and it’ll boot from 
the disc. If it doesn’t, you’ll 
need to change a setting in 
your computer’s BIOS/UEFI to 
put the optical drive first in the 
boot order. We can’t be specific 
about exactly what setting to 
change and how, given the 
wide variety of BIOS and UEFI 
systems out there, but watch 
out for a message displayed on 
your PC’s screen at boot time 
– you might see a window in 
which to hit an allotted key, 
usually [F2] or [Del]. If you 
know the model of your PC, 
check the manufacturer’s 
website for more instructions.
The process is also true if 

you’ve transferred an ISO 
image to USB for installation; 
while there are more steps to 
take, as long as your install 
media is set to boot first, you’ll 
be fine. You’ll need to ensure 
you have your drive inserted 
into a port before you boot to 
BIOS in order to set this up. 
Once you’re running the 
installer, follow the instructions. 
The Windows 10 install process 
is more simple and foolproof 
than before, and if you’re 
careful not to let it overwrite a 
partition you’re using, you’ll 
likely have no problem.

But wait! Hold fire if you’re 
looking to dual boot Windows 
10 with 7 or 8.1; before you 
install, unless you happen to 
have a spare partition, you’ll 
need to use the Disk 
Management tool within your 
old OS to resize your primary 
partition and separate off space 
for Windows 10 to install into. 

But wait… again! Before you 
resize your partition, make sure 
your files are arranged by 
defragmenting it, leaving space 

at the end to be reallocated. 
Right click your primary drive 
in Windows Explorer, select 
‘Properties’, open the Tools tab, 
and click ‘Defragment now’. 
Now click Defragment Disk to 
start the process. Launch the 
Disk Management tool by 
opening the run dialog with 
[Windows]+[R] then typing 
diskmgmt.msc. The interface 
shows the partitions that exist 
on your machine – you’ll 
probably have at least two, a 
small recovery partition and a 
much larger main partition, 
and it’s the latter we’re 
interested in. Check in the 
volumes list at the top of the 
window that your chosen 
partition has enough free 
space (at least 16GB for 32-bit 
Windows 10 and 20GB for 
64-bit, allocating more if you 
can). If you’re short on space, 
clear some files before 
continuing. Right click your 
target drive in the Disk 
Management tool and select 
‘Shrink Volume’, then input the 
amount of space you’re 
looking to claw back. Be aware 
that the tool is looking for this 
in MB rather than GB, so add 
three zeroes to the end of your 
intended space in GB. Click 
‘OK’ and the tool will go to 
work, and you’ll be left with an 
area on your drive labelled 
‘unallocated space’. We now 
need to turn this into a 
partition. Right click it, select 
‘new simple volume’, and click 
‘Next’. You can give this new 
partition any letter you like. 
Keep clicking ‘Next’ until you 
see the formatting options. 
Make sure you choose ‘NTFS’ 
as the file system, and label 
your drive before formatting 
the space. 

manage well Use the 
Disk management tool 

to help with your install

Boot Up Installing from a disc? then you might need to visit your UeFI system 



Learn how to…
Get started with 
Windows 10

“Now you’ve finally got Windows 
10 installed, it’s time to find out 
what it has to offer”

ow you’ve got Windows 10 installed, up and 
running, it’s time to see how the new system works. 
There’s a new Start menu for you to explore and 

some exciting new features. For example, when it comes to 
aiding productivity Windows 10 has plenty on offer. 
Whether it’s aero snapping your apps to corners or asking 
Cortana to help you out by setting reminders, it’s all there 
to streamline your daily computing. 

The best approach is to dive right into as many of the 
settings as you can – personalising your operating system, 
desktop and programs for the tasks you perform the most.

For instance, if Cortana isn’t your thing, or you prefer  
not to search on the desktop through Bing then you can 
remove that part from the taskbar at the bottom of the 
page. Doing this will give you more screen space, as well  
as a tidier desktop and leave you with more space to pin 
programs to. But, these are just a few ways to improve  
your Windows experience, read on to learn more.

1 Set up your screen resolution
To help increase your productivity make sure your screen is 

running at maximum resolution. You’ll find text and images are 
much clearer and easier to see. Right click on an empty area of 
your desktop and select ‘Display Settings’. You can now select 
‘Advanced Display Settings’ in the right-hand window. Here you’ll 
find the Resolution drop-down menu – select the highest option.

2 Switch to Tablet mode for 2-in-1 laptops
Open the Start menu and select ‘Settings’. Here you’ll  

find some tools you can configure to make your life easier. Go to 
System then Tablet mode. Enabling Tablet mode will make 
Windows 10 act more like Windows 8 – your apps will be fully 
sized and your Start Menu will expand to the entire screen. Ideal 
for 2-in-1 laptops and touchscreen all-in-ones.

Step-by-step Get started with Windows 10

Jargon buster!
 Resolution

The resolution is how 
many pixels occupy 
the screen. The 
higher the resolution 
the more dots and 
the clearer your 
images will be.

 Snapping
A way of arranging 
and resizing 
windows, by 
dragging them  
to the edge of  
your screen.
  

 Partition 
A separate segment 
of your drive split  
off to organise  
and protect your  
files from viruses  
or data loss.

Your guide Zak Storey says…

SettinGS
The Settings tab is 
the new control 
panel, you’ll find 
many customisation 
options easier to 
change here. 

ReSolution iS key
Setting up your screen 
correctly will ensure 
you can be as 
productive as 
possible, and save 
your eyesight as well. 

N
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3 Aero Snap in Windows 10
Snapping programs to the sides of the screen was a feature 

introduced in Windows 7. In Windows 10 you can now snap 
applications to each corner, as well as to the sides, by left clicking 
and dragging the top bar into a corner. You will also see a visual 
representation of how much screen space the app will take up. 
This makes it much easier to multitask with two documents.

4 Uninstall programs
Uninstalling old and unused programs can be useful for 

freeing up storage space on your PC. You’ll also notice your 
start-up times become speedier if you declutter. To do this, click 
‘Settings’ in the Start Menu, select ‘System’ then on the left tab 
select ‘Installed Apps’. Here you can remove apps by left-clicking 
them and selecting ‘Uninstall’.

BackuP
It’s always a good idea 
to create a backup of 
files and documents, 
so you don’t have to 
worry about losing 
your work. 

Multi-aPP VieW
This little button 
makes switching 
between apps 
much easier. 

SPace SaVinG
Removing old programs 
frees up storage space 
and means Windows 
won’t have to load  
up as many programs 
on startup. 

coRtana
Your personal 
assistant, ask it for 
anything and it’ll see  
if it can help, or just 
search the internet  
for an answer. 

Zak’S beSt tip!
Explore all the menus to 
discover all the options on 
offer. We guarantee you’ll 
find plenty of shortcuts  
and tricks that will soon 
become indispensable.
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9 Multi-App view
Another neat feature is the ability to swap between many 

apps at any time. Just press ‘Task view’, the button to the right of 
the search bar near the Start menu. This allows you to quickly 
switch between open applications (including minimised ones) 
without having to trawl through the icons on your task bar, 
making it much easier to find programs.

7 Cortana on call
If you’re signed into your Microsoft account you can use 

Cortana for many things from searching the internet, to setting 
calendar reminders or sending emails. To get going, just say “Hey 
Cortana” (making sure your mic is enabled) or type Cortana into 
the search bar at the bottom left-hand of your screen. If it can’t do 
something for you it’ll search the internet for the answer.

5  Create a secure backup
You’ll need around 120GB of excess storage in a separate 

partition or drive to create a secure backup of your PC’s OS and 
documents every week. Go to ‘Settings’ and select ‘Update & 
Security’, then click on ‘Back-up’ in the left-hand window. Click on 
the ‘+’ button and select the partition or drive you wish to use. 
Once done select ‘more options’, then ‘See advanced settings’.

10 Uninstalling the old Windows
So, it’s time to bid farewell to Windows 7 or 8 on your PC! To 

uninstall it, click on the Start menu and type in disk clean up, 
then open the ‘Disk Clean Up’ application. You can now select 
drive (C:), press ‘OK’ and let Windows scan the drive. Scroll down 
the open window and tick ‘Previous Windows Installation(s)’ tab, 
select ‘Clean up system files’ and you’re done. ■

8  Organise mail accounts into one
Keeping all email accounts in one place was a handy feature 

introduced in older versions of Windows 8. However, the Mail app 
that replaced Outlook has much more increased functionality. 
Click on the Mail icon in your Start window select ‘Add account’, 
select your email service and fill in the details. You can now select 
‘Done’ and all your emails will be in one place.

6 Finish the backup
Now click ‘System Image Backup’ in the bottom left-hand 

corner of the screen, and click ‘Set up Back-up’ on the right-hand 
side of the screen. Highlight the drive you want to use for your 
backup and click ‘Next’, then ‘Let Windows Chose’. Hit ‘Next’ again. 
You can now set up the schedule for when Windows performs the 
backup and then press ‘Save settings and run backup’.
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